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EN - http://www.lkc.com/IFUs Printable instructions for use (IFU) in multiple languages
are stored on the UTAS computer as PDF files in the IFU folder on the computer
desktop screen, or go to www.lkc.com/IFUs

DE - Druckbare Nutzungsanweisungen (IFU) in mehreren Sprachen werden auf dem
UTAS-Computer als PDF-Dateien im IFU Ordner auf Inrem Desktop gespeichert.
Alternativ kdnnen Sie www.lkc.com/IFUs besuchen.

ES - En el ordenador UTAS hay almacenadas como archivos PDF instrucciones
imprimibles de uso en varios idiomas, en la carpeta IFU del escritorio del ordenador, o
acceda a www.lkc.com/IFUs

FR - Des instructions d'utilisation a imprimer (IFU) dans plusieurs langues sont
stockées sur l'ordinateur UTAS sous forme de fichiers PDF dans le dossier IFU présent
sur le bureau. Vous pouvez également les obtenir sur www.lkc.com/IFUs

IT - Le istruzioni per I'uso stampabili (IFU) in piu lingue sono archiviate sul computer
UTAS come file PDF nella cartella IFU sul desktop. In alternativa, sono reperibili
all'indirizzo www.lkc.com/IFUs

PL - Instrukcje obstugi (IFU) do druku w wielu jezykach przechowywane sg na
komputerze UTAS jako pliki PDF w folderze IFU na pulpicie komputera lub na stronie
www.lkc.com/IFUs
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European regulatory Data
Instructions for USE (IFUs) in other languages may be found at www.lkc.com/IFUs
To request a printed copy of this manual please send an email to support@lkc.com and
include the following information:
1) Company name
2) Your Name
3) Mailing address
4) The Serial Number of your device
5) The part number of the manual you need
To find the correct part number, open the pdf file in the IFU in the language
you want and find the part number, the part number will appear on either the
front or back of the IFU. The manual part number will look something like 96-
123-AB.
Your manual will be shipped to you within 7 days.
Reference 96-020 UTAS Hardware User Manual for complete regulatory
information
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UTAS is the Trade Name for this device and all associated software. The lifetime of a
UTAS is 5 years from the original shipment date of the UTAS device. LKC will service
any UTAS that is within its lifetime.

SOFTWARE LICENSE
The UTAS software is a copyrighted product of LKC Technologies, Inc. and is included
with the UTAS under the following license agreement:

The software may be used in conjunction with the UTAS only. The purchaser of the
UTAS may make copies of the software for convenience of use, provided the LKC
copyright notice is preserved with each copy. This license specifically prohibits the use
of this software in a device that does not include an LKC Technologies, Inc. UTAS
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of UTAS data using a stand-alone computer system.
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UTAS EMWIN

1 Important Information

1.1 Intended Purpose and Intended Users

UTAS is an electrophysiology device used as a diagnostic and disease management
aid in visual pathway dysfunctions or ophthalmic disorders.

UTAS performs electroretinogram (ERG), electro-oculogram (EOG), visual evoked
potential (VEP), multi-focal ERG/VEP, and the measurement of psychophysical
responses of the visual system, including dark adaptometry.

This equipment is offered for sale only to qualified Health Professionals.

The intended users of the device are intended to be physicians, optometrists, medical
technicians, clinical medical assistants, nurses, and other health-care professionals.

1.2 Clinical Benefit

Assist health care professionals with diagnosis and management of ophthalmic or visual
pathway dysfunction/disease or to ensure drug safety.

1.3 Intended Target Groups
There are no specific intended target groups.

1.4 Indications for use

UTAS is indicated for use in the measurement of visual electrophysiological potentials,
including electroretinogram (ERG) and visual evoked potential (VEP). UTAS is also
indicated for use in the measurement of psychophysical responses of the visual system,
including dark adaptometry. UTAS is intended as an aid in diagnosis and disease
management in visual pathway dysfunctions or ophthalmic disorders (e.g., diabetic
retinopathy, glaucoma).

1.5 EMWIN software specific tests

The LKC Technologies EMWIN software performs the ERG and VEP tests to aid in the
diagnosis and disease management of visual pathway dysfunctions or ophthalmic
disorders.

The LKC Technologies EMWIN software is only intended to use used with the UTAS
device. The software will only run on computers using a Windows 10 or higher
operating system and having very specific video control hardware. LKC only supports
UTAS computers that have been supplied by LKC specifically for this software.
Reference 96-020 UTAS Hardware User Manual for details on UTAS hardware and
regulatory information.

1.6 User’s manual structure

This manual is divided into three components: The UTAS EMWIN Software portion, the
Testing the Patient portion, and the GLP/GCP Compliance portion. The Software
component covers all aspects of the software. Explicit instruction on testing patients is
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covered in the Testing component of the manual. It is important to be familiar with the
Software Manual and the separate Hardware Manual before you go through the Testing
Manual. Reference 96-020 UTAS Hardware User Manual for details on UTAS hardware
and regulatory information. The GLP/GCP compliance portion is applicable for those
who have purchased the additional GLP/GCP compliance software package.

This software is offered for sale only to qualified Health Professionals. The improper
use of this software with the associated hardware may cause injury to the patient.

1.7 Overview

This EMWin User's Manual is divided into two sections; the Software, and Testing
manuals. A separate UTAS Hardware Manual accompanies the UTAS device when it is
purchased. The Hardware Manual will explain how the device is connected, the
specifications for the device, how to use the hardware features, and how to assist LKC
in servicing should trouble arise. The Software Manual and the Testing manual, will
explain how to use the software and the details of performing a patient test.

1.8 Precautions for Software Installation

WARNING: The installation of any software on the UTAS Windows
based computer that is not provided directly by LKC can cause the
device to stop functioning, crash unexpectedly, or disrupt the timing
of the stimulus presentation and data collection.

The LKC UTAS device is a precision standalone medical device. The computer
provided with the device has been manufactured and configured for this specific
purpose. It is absolutely essential that the timing of the stimulus presentation and data
collection not be impeded by any non-LKC provided software products.

The warranty on the UTAS does not cover problems caused by installation of non-
approved software on the computer. The UTAS is a medical device that uses a
Windows-based computer. Installation of additional software on the UTAS computer
may result in improper operation of the UTAS. It is the customer’s responsibility to
ensure that any additional software installed on the UTAS computer does not affect the
performance of their UTAS. LKC is not liable or responsible for improper operation of
the UTAS caused by customer-installed software.

Therefore, LKC strongly recommends that UTAS be used as a standalone medical
device. LKC also strongly recommends that:
1. The user does not change any user privileges or software settings.
2. No non-LKC approved software products be installed on the device
3. The supplied EWMIN software is not standalone and is only intended for
use with the UTAS.
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2 Introduction

The UTAS software is called EMWIN; it handles all of the details of performing a test —
presenting a stimulus, collecting and analyzing the data, storing results, and printing a
report. This section of the manual details the use of the EMWIN software. This manual
assumes familiarity with the basic operations of the Windows operating system.
Note: The computer must be powered by one of the isolated
outlets on the Interface Unit. This means that the computer will
lose power when the Interface Unit is turned off. Make sure to save
all data BEFORE and properly shut down the computer turning off
the Interface unit.

3 Using the Device

3.1 Starting and Quitting the Device

To start using the device, first turn on the power of the Interface unit. Then make sure
all peripherals are on (pattern monitor, printer, user monitor, and turn on the computer.

Once the computer boots the EMWIN software will automatically open up to the main
menu.

To turn off the device click on QUIT in EMWIN main menu, turn off the computer by
going to Start -> Turn OFF Computer -> Turn OFF.

Once the computer has powered down, power off the Interface this will turn all the
peripherals off as well.

3.2 The Main Menu

The Main Menu is used to access all EMWin’s features. The four sections are Perform
Tests, Create Reports, Design and Manage Protocols and Utilities.

While the Protocols or Utilities functions may not be used on a daily basis, it is still
necessary to understand their functions.

TESTS: Clicking on this button will allow the user to perform all visual electrodiagnostic
tests that the instrument is configured for. This segment of the program allows for the
collection and storage of data and will be the most frequently used function of EMWin.
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REPORTS: This module allows the & forWindowsyersionas x
user to not only print reports, but also

analyze the data. Stored data can be ® . L K C
recalled and displayed before being & iotoon
analyzed and the reports printed out. '

PROTOCOLS: EMWin allows the user
to design their own testing protocols.
This part of the program allows for the  crentatavsse: resTve

specification of the individual
parameters to create specific protocols.

UTILITIES: This section of the program
allows the user to change the practice
information, edit data and databases,
and change the device setup.

3.3 Setting Preferences in Utilities

Although the software and hardware for the LKC UTAS are, for the most part, set up at
the factory before shipping, there are a few tasks that must be performed to complete
the setup procedure.

3.3.1 Entering the Report Header

EMWin will print out up to four lines of
text at the top of each printed report.

This text is norma"y the name and Line 1 |LKCT&chnqugies

address of the practice, but it may be

any other four lines of text wanted. In Line? (Y wmsr=

order for EMWin to print out this
information, the information must be Line 3 [y
provided in this section. S G trersbura. 1D 20579

Line 4 WA LKC.COM

Practice Information

From the Main Menu, click on
Utilities and choose Change
Practice Information. A Text Fill-In
menu will appear that will allow the
user to specify the name and address
to appear at the top of the report. (If this information is left blank, no information will be
printed.) Each line may have no more than 32 characters in it, so plan the header
carefully. Because this information will appear at the top of every report that is printed,
make sure that there are no errors.

[ concet

3.3.2 Creating the Storage Database
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EMWin allows for the creation of Access databases in which waveforms can be stored.
All of the waveforms in one database are hidden from the waveforms in other
databases. One method for organizing the files is to create different databases to store
them. EMWin will allow the user to specify which database is to be used to store and
retrieve waveforms. All of the waveforms in this database are unique and different from
those in other databases. For example, it is possible to have several subdirectories
called data2007, data2008, data2009, etc. Waveform number 1 in data2008 is totally
unrelated to waveform number 1 in data2009.

Although each database can theoretically hold an unlimited number of waveforms, the
search performance of the computer slows when there are more than a few thousand
waveforms in a single database. Therefore, it is recommended to take some time to
decide how to organize the storage of waveforms. Depending on how many waveforms
will be recorded per month, there can be different database for each month or each
year, or per different studies...

Select Utilities from the Main Menu, and then choose Create New Database and

Standard Database from the popup | guorwindows x
menu. A screen will then allow for the

naming of the new database. Please enter a name for the new database:
NOTE: The database should only _Cancel |
contain letters A-Z or a-z and/or

numbers 0-9 (no spaces allowed) IData2019

*| EM for Windows 10 Version 9.7.0

Once the database has been created,
don’t forget to select it to start storing & . L K C
waveforms in the created database. &

See the next section for selecting a
database.

TECHNOLOGIES

3.3.3 Selecting the Storage Current database: DATA2019
Database

EMWin allows the user to store
waveforms in different databases. To
select which database to work with,
select Utilities from the Main Menu.
Choose Select Database and
Standard Database from the popup menu. A screen appears that lets the user choose
the database desired and also informs them of the current database. This selection
determines the location where test data will be stored, as well as which database will be
called when reports are created.
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Select Databasze

Please select the database

where waveforms should be DATAZ019
stored. DEMO_DATA
TEST03132019

This database also determines
the waveforms to be shown in
Reports

The default is: EMDATA

Current Database

DATAZ01S

EMWin’s Main Menu automatically displays the current database in use.

3.3.4 Selecting the Date Format

The date format is defaulted to YYYY-MM-DD; however, the date format may be
changed to DD/MM/YYYY or MM/DD/YYYY by going into Utilities and System
Preferences.

Preferences

Remove Interference
@ sine Wave Q9 Harmonic

Powerline Frequency (Hz)
@ 50 & 60

Date Format
@ MMIDDYYYY P DDIMMMYYY 2 Y IMMIDD An alysis Opti ons

Print Font Style (Difference row) Auto Cursor

v alin
Bold Italic op Fiter T

Print Cursor with Label
With Labels save to file

SunBurst/Big Shot Options

RedHelper Intensity

System Setup

3.3.5 Selecting the OP Filter

The software can be used with custom OP filters. The software is preloaded with the
following OP filter frequencies: 45 Hz (Mouse), 75 Hz (Human), 100 Hz, 125 Hz, and
150 Hz. To use any of the filters, select them from the dropdown list (see preferences
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window in section 10.3.4). If user defined filters would like to be used (up to 500 Hz),
simply type in the drop-down box the filter frequency desired.

3.4 More on Utilities

Initial set up of preferences for Practice Information, Database and Date format are
covered in section 10.3.

The next section of the mgnual will Change Practice Information

be devoted to covering the Create Mew Database >
remainder of the Utilities menu. Select Database ’
| Database Tools 3 || Backup Current Database

Edit the Diagnosis List Edit Current Database

Systern Preferences

3.4.1 Backing Up Databases

Utilities -> Database Tools -> Backup Current Database. It is good practice to
frequently backup the data. How often depends on how much data is willing to be lost.
To backup a whole database, go to Utilities -> Backup Database. Select the database to
backup (the currently used database is displayed on the bottom part of the main menu).

Highlight the database to be backed up and then select which location it should be
saved in. It is recommended that databases be backed up to a different filesystem
(such as an external USB drive) than the original database.

3.4.2 Editing a Database / Patient Information

Utilities -> Database Tools -> Edit Current Database. It's possible to change the
information in the database; to delete waveforms and edit patient information. For
example, if a patient was tested and the patient's last name was accidentally
misspelled, the problem can be fixed by going to edit current database, finding the
waveform of the patient (by using the waveform number) and clicking on edit patient
information. There, it is possible to edit: first name, last name, date of birth, label of the
eye (R, L, OD, and OS), diagnosis and comments. Then proceed to the next waveform
that needs editing.

3.4.3 Editing the Diagnosis List

When entering the patient information, it is possible to select a diagnosis to associate
with the patient data. A new diagnosis can be selected from the drop-down list or typed
directly in the patient information window (the program will automatically add to the
diagnosis list). However, if you need to edit or delete some of the diagnoses you will
need to go to Utilities -> Edit the Diagnosis List.
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3.4.4 Device *) EM for Windows Version 9.8.1 x
Preferences
Powerline Frequency (Hz) — Set ;: L K C

this to whatever power line
frequency is used in your
location. This setting helps

EMWin reduce powerline
interference in test results.

Electro-retinogram 4 ISCEV 4-Step

Print Font StV/e (Difference Visual E‘.rloked Response » ISCEV 5-Step
N . User-Defined Protocol 4 ISCEV 6-5tep
Row) - This specifies the Classic
difference row of the cursor Flicker
printout in bold or italic. Note Bright Flash
that the choice is possible only :”-’°”R°5F°”*
. . . tter
when Print Cursor with Label is e .
Retinal Ischemia Moenitor
nOt Checked Photopic Negative Response
S-Cone
Screen SIZG Double Flash

Trigger Input

Used to optimize viewing when
using a secondary computer for data analysis.

System Setup contains all information specific to the device and should not be changed
unless indicated by an LKC Technologies engineer.

Preferences

Remove Interference
@ sine Wave Q@ Harmonic
Powerline Frequency (Hz)
@ 50 9 60
Date Format
» MM/IDDMYYYY P DDIMMMYYY D YO IMMIDD Analysis Optil)l‘ls

Print Font Style {Difference row) Auto Cursor

v alir
Bold Italic op Fiter T

Print Cursor with Label
With Labels save to file

SunBurst/Big Shot Options

RedHelper Intensity

System Setup

3.5 Performing a Test
This section covers procedures that are common to all tests run using the UTAS.

3.5.1 Selecting a Test
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To perform a test with the EMWin, click on Tests from the Main Menu, and choose the
test to be performed. The options are:

¢  Electroretinogram

¢ Electro-oculogram

¢ Visual Evoked Response

¢ User Defined Protocol

After the type of test that you wish to perform has been selected, another menu will
appear asking for the specific test to perform. Click on the appropriate test from that
menu.

3.5.2 Patient Information

After the test has been chosen, EMWin will provide a screen to enter patient
information.

It is important to stay consistent in the format of entered information, otherwise, data
analysis and retrieval could be more difficult.

If more than one test is run in the same EMWin session, the demographic information
from the last patient tested will appear as the default values for the next test. To clear
this information, simply click on the Clear button at the bottom of the menu. This will
delete all information and allow new patient information to be stored. Fill in all of the
items deemed appropriate (it is not required that all fields be filled).

Depending on whether the test subjects are animals or humans, there can be two
different patient information windows. EMWin is defaulted to the human information
window. If the animal version is required, go to My computer -> C:\EMWIN, open the
temp folder, and rename the file Animal_Demographics.txt to Demographics.txt.

When the data is retrieved after testing, the patient information entered can be used to
make data retrieval easier. The searchable items are marked with an asterisk. ()

Last Name*, First Name*, Middle Initial* - The first letter of names does not have to be
capitalized, since EMWin will automatically capitalize them when data is stored. There
is space for 16 characters in both Last Name and First Name and 2 characters in
Middle Initial.

Sex* and Birthdate™ - The Sex field should be entered with either M or F.
Identification* - There is space for 16 characters in the ldentification field. Any
alphanumeric combination can be used for this information. It could be the patient’s

Social Security number, or their medical ID code.

Pupils Dilated - Record in this field whether the patient’s pupils were dilated with
mydriatic eye drops for this test.
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Diagnosis - A diagnosis can be typed into this field or choose one from the pull-down
menu. The typed diagnosis will be automatically remembered and added to the list.
The list can be edited to add or remove or correct spelling by going into Utilities and
Edit the Diagnosis List (see section 10.4.3).

Electrode Type - For ERG testing, choose the type of the electrode used in the test from
the drop-down list.

Dark Adapt Time - Record the amount of time in minutes that the patient was dark
adapted before ERG testing.

Other* - This field allows any additional information to be recorded. When the records
are retrieved, this field is searchable. Thus, it may be useful for recording information
such as participation in studies.

Database — This window shows the current database where the data will be stored.
Another database can be selected from the pull-down menu. However, to permanently
store the data in a database other than the one defaulted; it must be changed in the
Utilities Tab. Refer to section 10.3.3 for instruction on how to “Select the Storage
Database”.

Comment - Enter comments here about the patient that will be stored with the data.
There is no restriction in length. Typical comments might include symptoms the patient
presented with, referring physician, or classification in a study group.

The “Continue” button -When you have completed all of entries, click on this button to
continue.

The “Cancel” button - This will return the screen back to the main menu.
The “Clear” Button - This will clear out all of the information in the fields.

The “Search + Fill” button — This will search the current waveform database for
matches. Fill in the patient's Last Name and click on this button. If the device finds a
match, it will fill in the remaining items based on the information stored in the database.
If no matches are found, a notice will appear, and the information may be entered
manually.

3.5.3 Channel Information

Once the patient information has been entered, click the continue button, and the
channel information menu will appear. Select the number of channels to be recorded
from and place the Label for each channel.

The software defaults R in channel 1 and L in channel 2 for ERG and Oz in channel 1
for VEP. Note that for VEP testing you will also need to select the eye to be tested.
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Channel Information Channel Infermation

- Select Eye to be Tested: ——
Number of Channels Number of Channels |§

Channel 1 Label Channel 1 Label 0z @ Right (0D)
Channel 2 Label i Lefi (0)

@ Both

=l e

ERG VEP

If only one eye is tested, channel 1 should be used regardless
of which eye is being tested.

3.6 Icons and Menus

3.6.1 Parameters

By clicking on parameters in the upper menu bar or the Amplifier (gear), or the light bulb
icon, the parameter window will open.

*| EM for Windows
Parameters  Step  Analyze  Graph Properties Print Undo  Record

®O<>%0BSkiiksslno

The parameters window contains four tabs: SunBurst Flash, Averaging, Amplifiers and
Timebase.

SunBurst/BigShot Flash Parameters

This window allows the user to change the flash color, intensity, flicker rate as well as
the background light intensity and fixation light.
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Test Parameters

A\aeraging])\mpliﬂers Timebase 5UnBLIFStF|EISh]

Test Type |Single Flash -

1st Flagh
Stimulus Source
+ LED " XENON

Intensity(dB). |24

™ Background Light

Color

{* White

" Red 1 Green 1 Blue
" Custom Color

InfraRed Fixation Light
V¥ on " off

(* Dim

" Bright

There are 4 different options for the Ganzfeld flashes:
Single Flash

Double Flash

Flicker

On/Off

PN

The range of the intensities depends on the stimulus source (LED, Xenon or UV if

applicable)
For LED flashes, the x, y coordinate of color can be entered according to the CIE color
diagram below. Note that only colors within the inner triangle can be achieved.
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0.9
520
O:50 540
0.7+
60
0.6 "
5001 4
0.5 i . i 580
y
0.4 600
620
0:31
19 700
0.2
480
0.1
470
0.0+— 400" 7350
0.0 0.1 0.2 0.3 0.4 0:5 0.6 0.7 0.8
X
CIE Color Diagram
In order to produce:
- Pure red LED stimulus enter x=1,y=0
- Pure blue LED stimulus enter x=0,y=0
- Pure green LED stimulus entre x=0,y=1

Pattern Parameters
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1 EM for Windows
Parameters  Step  Analyze  Graph Properties  Print Undo  Record

® O <> %0 B /k/ilsfne

In the case that a pattern stimulator is being used, the icons above will appear. The
Checkerboard icon will open the pattern parameters.

Pre-Adapt Time specifies how long the pattern will alternate before the actual recording
starts.

Pattern | Averaging ] Amplifiers ] Timebase

x Video Centrol

Style Orientation Pasition Contrast
(9] 5
™ Sinusoidal - Full Sereen 7JE1 o
B e -HaIFScrEen 290
o . . - Quarter Sereen ign
& Checks Dimension Selection E?n
32432 -
H =)
Color 1 i50
Pre-Adapt Time in seconds = € Fed £ Graen € Blus © Black ® whit 40
Color 2 EBU
" Red " Green " Blue * Black " white =0
o
Allemations/sec Pattern Blank On/Off Ratio 52
[ 2
20z ] ; ¢ Vallie100%

181 41 21 11 12 T4 18 118

Intensity ed/nf

Pattemn Model
e | = |
* Altemating Pattern " Patterr: Blark Freview
Cancel

Averaqging Parameters
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Test Parameters

Averaging | Amplifiers | Timebase | SunBurst Flash |

Mumber of Sweeps to Average:
Time Between Sweeps (seconds):
Sweeps Before Update:

Artifact Reject (microvolts):

Display Raw Waveform: Mo

3 wl [==] = = =y
= L
w w

Store Individual Sweeps: & No

I~ Disable Electrode Connection Monitoring

The Averaging Menu will appear, allowing the modification of the following options:

. Number of sweeps to average

. Time between sweeps (seconds): At least 5 - 10 seconds between flashes is
necessary for scotopic testing to avoid light-adapting the subject during averag-
ing. To manually reject waveforms, it is recommended that this be set to at least

2 seconds.

. Sweeps before update: Number of sweeps to acquire between screen displays of
averaged waveform data.

. Artifact reject (microvolts): Threshold for rejecting artifacts. This option allows

automatic rejection of waveforms during averaging that exceed an amplitude
criterion. If zero is entered, the artifact reject option is disabled. If the artifact
reject threshold is set to a value that is higher than the input range of your
chosen amplifier gain setting, EMWin will instruct the user to lower the artifact
reject threshold.

. Display raw waveform: Whether or not to display each waveform as it is
acquired. For single flash ERGs, each response is usually viewed as it is
generated. However, for VEP tests, each individual response is typically
meaningless since it is usually embedded in noise. To manually inspect
waveforms and reject them individually, each waveform must be displayed as it
is acquired.

. Store individual sweeps. Typically, EMWin only stores the final average of all
sweeps from one test, and the individual (raw) responses that make up the
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average are discarded. This final average uses a trimmed mean (rather than an
average) in order to automatically reject artifacts. If, however, you want to reject
artifacts by hand, select Store Individual Sweeps. All the individual responses
will be stored in the database (up to 200 responses) in addition to the final
average. In Report mode, these individual responses can be included or
rejected from the averaging.

. Disable electrode connection monitoring: Allows users to select whether the
software should detect if an electrode becomes disconnected. If the system
detects an electrode disconnect event, testing will immediately stop, and the
operator will have to reconnect the electrode before restarting the current test
step.

Setting any of these parameters to “0” disables that option.

Amplifier Parameters

Test Parameters

Averaging Amplifiers | Timebase SunElurstFIash]

Gain
Ch1 Ch2 Ch3 Chd Chs Chi

5 =l e =l =l e =l =l e 1

High pass Filter (Hz)

Low pass Filter (Hz)
Ch1 Ch2 Ch3 Ch4 Chbs Ch&

300 Hz ~| [s00hz =] [s00Hz ~| |s00Hz | Jaoohz v| [s00Hz |

Notch Filter
* of ¢ On

This selection is used to change the amplifier gain or filter settings for the protocol.

If the default values of the High Cut and Low-Cut filters are changed,
the waveform may significantly be altered.
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The “Notch Filter” will selectively reduce 60 or 50 Hz powerline interference. Typically,
excessive powerline interference can be reduced by better electrode placement or by
moving the patient away from powerline sources. However, the notch filter can be
turned ON if all other noise reduction techniques fail.

Timebase Parameters

Test Parameters

|| SunBurst Flash

Timebase

Mumber of
Samples

Sample Rate
(Hz):

Sweep Length
(milliseconds):

Pre-Stimulus
Baseline
(milliseconds):

¢ Sample Rate and Sweep Frequency - This screen allows the user to control
the sampling frequency (default is 2 kHz). A single recording sweep always
includes 512 samples. If the Sample Rate is changed, the Sweep Length will
automatically be updated.

¢ Pre-Stimulus Baseline - A Pre-Stimulus Baseline allows the user to adjust the
amount of data to be collected before the stimulus is presented. Typically,
this is used to indicate the amount of baseline noise present just prior to a
flash stimulus.
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A “Pre-Stimulus Baseline” cannot be entered when performing a
flicker test and the software will automatically set this parameter to 0
if attempted.

EOG Parameters

B foG

EOG LEDs

Brightnessz | Dim
Duration |15 zec
Frequency |1 5Hz

EOG Recording Time
Pre-adapt |5 i
D ark-adapt ,m iy
Light-adapt |20 Thin

EOG Backaground Light

Pre-adapt ’W‘
Light-adapt |High

Fast EOG

TotalTime min
Background |High

EOG Select |EOG anly

Chart Scale: 16 hd

Amplifier Gain: |4

Brightness - If the patient is having trouble seeing the Red LEDs, the brightness of the
LEDs can be set to a higher setting.

Duration - The duration of the recording time is 15 sec, meaning that the LEDs will
alternate from right to left for every first 15 sec of each minute.
Frequency - If the patient has problems following the LEDs, the alternation frequency

can be slowed.

Auto Save Sweeps — The raw data of every sweep can be saved to file. The files will be
saved under C:\EMWIN\EOGData. The sweeps will be saved as sweep_001.txt and so
on up to sweep 999.txt

The settings in EOG recording time are preset to the ISCEV standard and usually do
not need to be changed. However, if the patient has reached the lower value in the dark
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adapt time, the time may be shortened while the test is being run. If the patient has
reached the peak in the light-adapt phase, the test can be stopped; all information
needed has been recorded.

The EOG backgrounds are set to low for Pre-adapt and Medium for Light-adapt.
According to ISCEV standard the eyes of the patient must be dilated for EOG, so it is
not recommended to use the high intensity background on dilated eyes.

Display Scale - If the data seems too large for the window, change the display scale to
a lower setting.

Custom Intensity Background Light - for UTAS SunBurst and E0G Background Light
BigShot user, the light adapt phase can be set to a custom Fre-adapt | Medium
intensity; just select Custom in the Light Adapt drop down list

and type in the desired value. Light-adapt [Hih <]
3.6.2 Analyze
Once waveforms are displayed, many analysis _
. | EM for Windows
features can be implemented. For each _ _ _
Retrieve | Analyze | Graph Properties  Print

function, the device will ask which waveforms S

are to be acted on. ‘ Q ‘ Baseline Correct E ‘ m

Invert

Report M Add Waveforms
Off-Line Average

Remove Interference

Analyze Oscillatory Potentials

Flicker Amplitude and Timing

Retinal Ischemia Monitor

Fast Fourier Transform
Smooth —

Smoothing can be achieved by going

3~ | to Analyze -> Smooth or by clicking on the icon.

The smoothing algorithm is useful for removing excess high frequency noise from a
waveform. The smoothing procedure consists of replacing each point in the waveform
by the average of the surrounding 11 points (five on each side plus the point itself).
This process acts as a high-cut filter that preserves the latency of all of the features of
the waveform. If smoothing the waveform once does not provide sufficient noise
reduction, the smoothing operation can be performed multiple times.

Warning: Smoothing a single flash ERG waveform will remove any
oscillatory potentials and may change the initial slope of the a-wave.

Baseline Correct
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Baseline Correct can be achieved by going to Analyze -> Baseline Correct or by
~~~ | clicking on the icon.

The purpose of baseline correction is to remove any slope or ultra-low frequency noise
from the data that might interfere with estimating amplitudes. Baseline correction is
accomplished by performing a linear regression on the data and subtracting the
resulting line from the waveform. If the stimulus is flickering, the slope of the line is
estimated from the entire waveform; otherwise it is estimated from the pre-stimulus
baseline. Thus, if a waveform has an overall upward slope, baseline correction will
remove it. If the waveform goes first up and then down (or vice-versa), the baseline
correction function may not be useful.

Invert

A~ | Invert can be achieved by going to Analyze -> Invert or by clicking on the icon.

AVa\

A waveform may be inverted (make positive-going potentials appear below
baseline and negative-going potentials appear above baseline). This feature is useful if
you wish to make the waveform appear as if you had interchanged the + and -
connections to the patient amplifiers. It is also useful for subtracting waveforms. (See
Add Waveforms)

Add Waveforms
Add Waveforms can be achieved by going to Analyze -> Add Waveforms or by
+ clicking on the icon.

Two or more waveforms may be added together by selecting Add Waveforms. All of
the waveforms chosen will be added together and will replace waveform 1 on the
screen. (The original waveforms will be removed, leaving only the summed waveform.)

Two waveforms can be subtracted by first inverting one of them (see Inverting
Waveforms above) and then adding the two together. For example, it is possible to
subtract a Scotopic Red ERG from a matched Scotopic Blue ERG to remove the cone
contribution and obtain a good estimate of the isolated rod ERG.

Off-Line Average
w+w | Off-Line Average can be achieved by going to Analyze -> Off-Line Average or by
2 clicking on the icon.

It is possible to retrieve and average waveforms that have previously been stored to
disk. This process is called off-line averaging. First, open all of the waveforms to be
averaged, placing all of them on the screen at one time. Then select Off-Line Average.
All of the waveforms chosen will be averaged together and will replace waveform 1 on
the screen. (The original waveforms will be removed, leaving only the averaged
waveform.)

Remove Interference
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- | Sometimes, despite all precautions, a recording will contain some power line
N\ | interference.  If desired, EMWin will estimate the amount of power line
interference in the waveform and remove it. Of course, after the waveform is
stored, there’s no way to know how much of the signal at the power line frequency (60
or 50 Hz) is noise and how much is part of the original signal, so EMWin subtracts all of
it out. Except for 30 Hz flicker (where there may be a substantial real component at 60
Hz), this subtraction should cause no problems.

Removing power line interference after the test has been performed can clean up a
waveform that has some noise in it, but it will not rescue an otherwise uninterpretable
waveform. If the power line interference is larger than the original signal, the waveform
should be discarded.

Analyze Oscillatory Potentials
Analyze Oscillatory Potentials can be performed from Analyze -> Oscillatory
W potentials or by clicking on the icon.

Oscillatory potentials (OPs) are fast wavelets on the ascending edge of the b-wave of
the flash ERG. They have been shown to be a good predictor of progression of
neovascularization in patients with diabetic retinopathy or with central retinal vein oc-
clusion (CRVO). There are two methods to obtain OPs from the EMWin.

The first method that can be used to extract OPs (and the one that LKC recommends)
is to record the flash ERG with the low-cut filter set normally, and use the software
filtering system to extract the OPs. The software filtering method results in a more
accurate representation of both the amplitude and latency of the individual OP wavelets.

To use the EMWin software to determine oscillatory potentials, record the OPs using
the either the Standard or the Bright Flash ERG protocol (The Standard protocol follows
the ISCEV guidelines for recording oscillatory potentials, while the Bright Flash protocol
more closely approximates the technique of Bresnick et al.). Store the raw waveforms.
Click on Analyze and select Analyze Oscillatory Potentials. After the waveforms from
which to extract Ops have been chosen, EMWin will filter the waveforms and display
them on the screen. The waveforms may then be stored again.

After the waveforms have been filtered to extract OPs, EMWin will ask if to
automatically place cursors on the OP wavelets. If this is desired, click Yes. The
program will then place cursors on the oscillatory potentials (at its best guess for the
maximum and minimum for each one) and will determine the summed OP amplitude.
EMWin will place up to 10 cursors on up to 5 OP wavelets. To access the cursors of
these wavelets, use the Cursors option from the Reports Menu. The summed OP
amplitude will be reported at the top of each analyzed waveform.

The second method is to record the flash ERG with the low cut filter of the patient
amplifiers set to 75 Hz. The 75 Hz filter will remove the low-frequency components of



UTAS EMWIN

the ERG, leaving only the higher frequency components, including the oscillatory
potentials. (Step 3 of the Standard ERG Protocol implements this filtering.)

The cursors may also be manually placed on the Ops by selected Cursors from the
Reports tab or the button bar.

Flicker Amplitude and Timing
Flicker Amplitude and Timing can be performed from Analyze -> Flicker
N Amplitude and Timing or by clicking on the following icon.

EMWin provides a means of determining the implicit time and amplitude of the flicker
electroretinogram. This technique only works for flicker rates of 20 Hz or faster. The
implicit time estimates are derived somewhat differently from the normal technique of
placing the cursor at the peak of the response. The technique used by EMWin
estimates implicit time based on finding the center of the response; this technique has
been proven effective in prediction of neovascularization of the iris in central retinal vein
occlusion. (CRVO)

To automatically determine implicit time and amplitude of a flicker ERG, click on
Analyze and select Flicker Amplitude and Timing. Select each waveform to analyze.
The analysis will then be performed.

After the analysis is complete, the estimates of Amplitude and Implicit Time
(abbreviated Ampl. on the screen) will be displayed. This technique does not affect the
placement of cursors on the waveform, nor does it place any cursors of its own.

Retinal Ischemia Monitor

This can be found under Analyze -> Retina Ischemia Monitor

The Retina Ischemia Monitor (RIM) algorithm developed under a grant from the
National Institutes of Health, analyzes 30 Hz flicker ERG waveforms to provide
information about the extent of ischemia (inadequate blood supply) in the retina. Implicit
time provides more information than amplitude. The implicit time reported by Retinal
Ischemia Monitor is not the same as the implicit time of the peak of the waveform.

Fast Fourier Transform
Fast Fourier Transform can be performed from Analyze -> Fast Fourier
FFT Transform or by clicking on the following icon.

The Fast Fourier Transform is computed for selected waveforms, giving information on
specific frequency components of waveform data. It is possible to determine the
amplitude and phase of a specific component using the mouse.

3.6.3 Undo

This will remove all the analysis that was performed on the waveforms prior to saving
(smooth, analyze OP, auto scale....)
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3.6.4 Graph Properties
These options control how the data is displayed on the graph.

*) EM for Windows
Parameters  Step  Analyze | Graph Properties | Print  Undo  Record

OISR i NPT 1te)

| Line Thickness 3 | Thin

Test Mode Data Layout » Thick
Setup Mormal Data Extra Thick

Test Date: Thursday, Marc Show Flicker Labels

Show Normal - This function will write the upper and lower normal limits of the standard
ERG adjusted to the age of the current patient. This function is toggled on/off to
add/remove the normal data from the waveforms. LKC only provides normal values for
the standard 5 step ERG protocol.

Auto Scale - This will expand all waveforms to fit closely within the waveform’s axes.
Although the Auto Scale feature make waveforms look larger in amplitude, these large
amplitudes can be deceiving, since even small-amplitude signals will be expanded to fit
the entire graph. Please use this feature with caution when analyzing waveforms.

Line Thickness - This option allows the user to choose from among Thin, Thick, and
Extra Thick for the thickness of the line. The default is Thin. Thicker lines may be
useful for easier visualization, especially on printouts and faxes.

Data Layout - This allows the data to be displayed as separate data sets or overlapping
data sets.

3.6.4.1 Setup Normal Data —

This allows practice-specific normal data to be entered for the standard 5 step
ERG protocol so that it displays when “show normal” is selected. It is
recommended that each institute develop their own normal data. Normal data
differs for each electrodes type (ERG-Jet, Burian Allen...) particularly in
amplitudes. Only use this feature for 5 step ERG protocols.
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Setup Mormative Data
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Show Flicker Labels - Choose whether each flash will be represented by an upside-
down triangle on flicker waveforms.

3.6.5 Retrieve

Search -This option returns the screen back to the Patient Information Screen and
allows a new search to be performed.

Next - Selecting Next will display the next waveform(s) stored in the current database.

Previous - Selecting Previous will display the previous waveform(s) stored in the current
database.

Re-Read - Clicking on Re-Read will redisplay the current waveform. This is especially
useful when analyzing data and the original, unedited data is needed.
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Add More - Clicking on Add More will open the search waveform window and allow
adding more waveforms to the report.

3.6.6 Record
@ This will open a window streaming the real-time data: baseline.

Running the baseline is the first action to do when starting a test. Once this
button is clicked, real time acquisition of data is observed. A good baseline be
reasonably flat and should have minimal 50/60 Hz cycle noise.

Baseline — starts streaming real time data, click stop to stop the baseline recording.

Record — From the baseline menu it is possible to start recording immediately by
clicking on Record Data

@ Data Acquisition x
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3.6.7 Store

This stores the waveforms in the currently selected database. Choose to save all

W displayed waveforms or select the one to be saved. The waveforms are saved

back to back and given a number. The latest saved waveforms will be the
waveform with the highest waveforms number in the database.
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3.6.8 Step
« EM for Windows
Parameters | Step ‘nalyze  Graph Properties Print  Undo  Record
Step Forward O - A -
Step Backward — NN f , {‘
— ! Step to: » | k ——

Name: Santosa, Joshua
Test Date: Tuesday, August 3, 2021

B

of 7: Dark adapt (20 min)
VERIFICATION

- |
To proceed to another step in the protocol, click on step. Select Step Forward to
proceed to the next step in the protocol, or select Step Backward to proceed to the
previous step. The appropriate stimulus conditions and step number for the step will
appear at the bottom of the screen.

There are several ways to move forward and backward. Use either the arrow icons,
pointing left to move backward pointing right to move forward or by clicking on Step,
then Forward or Backward or Step To, to jump to any of the steps in the protocol.
Finally, it is possible to use the keyboard F3 to go backward and F4 to go forward.

*| EM for Windows
Parameters  Step  Analyze  Graph Properties Print Undo  Record

® @< > % 0B xk|ias |5

3.6.9 Place Cursors

Eﬂn In order to measure the amplitude and time of specific locations of waveforms,
use the Place Cursors feature. It is possible to place up to 10 cursors on each
waveform, although only two or four cursors for a single response are typical.

Wave 1‘ o1
Number
L

lace e
Remove Set | Remove All

+ A new box (picture above) will be shown at the bottom of the screen, which
indicates that the cursors will be placed on Waveform 1. Also, notice that a set
of cross hairs is placed on the first (top) waveform on the screen.

+ Left-Click on the waveform on which you want to place cursors on.
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+« EMWIN will automatically select Cursor 1 to start with, which indicates that
cursor 1 is the cursor to be placed on the waveform.

+ Use the Left Arrow («) and Right Arrow (—) keys to slowly scroll through a
waveform. As the cross-hair moves, the amplitude and time data will
automatically update. Hover the mouse arrow over the point to place the cursor
and left click on the mouse, this will also place the cursors.

+ To move through a waveform faster, use the Page Up and Page Down keys.

+ When the cross-hair is located at the data point of your choice, press the Enter
key. This will place a marker on that waveform. Use the Place Cursor button at
the bottom of the screen.

+ After Enter is pressed, notice that the selected option is now 2, since EMWin
assumes the cursors will be placed in sequential order.

3.6.10 Print

El The currently displayed waveforms can be printed to any standard Windows
printer. After clicking Print (from either the menu option or the toolbar button), a
Print Preview of your data will appear, showing how the data will appear when
printed. Words that may appear jumbled on the preview screen will be expanded to
appear normal on the printout. Double-click the left button to zoom in or double-click the
right mouse button to zoom out. To print the data, click on the Print button.

The first page will have the patient name, their birthdate, the waveform pictures, and the
cursors for each waveform. It also shows protocol information, number of average
waveforms and test date. The second and third pages contain all the patient
information, comments entered and all analysis routines that have been performed on
each waveform.

The user also has the option of printing the report to a pdf format. After clicking Print
(from the menu option or toolbar button), the Print Preview appears. Click on the Print
button after the pages desired have been selected. Another window will appear, where
the printer to be used can be selected. Select Microsoft Print to PDF as the printer in
the scroll down menu, and press print. Instead of printing, a save as box will appear
where the destination and name of the report can be entered.
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Print Preview

Double - Left Click on Image to Zoom In
Double - Right Click on Image to Zoom Out

If printing with the purpose of faxing the waveforms, the lines will
need to be thickened (see section 10.4.4). Graph Properties -> Line
Thickness -> Thick

3.6.11 Update Patient Information

« | This allows the user to change the patient information or enter comments during
recording. The changes need to be made before the waveform is saved to the
database.

3.6.12 Change Channel Information

This icon allows the user to view the number of channels that are being used at
f'ﬁ" that time. From this window, the labels for the channels (automatically filled in as
R in channel one and L in channel two) can be changed.

3.6.13 Measure Interference

The measure interference button collects one sweep of data from each channel
A\ | and determines the amount of main interference (50 Hz or 60 Hz, depending on
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configuration); measured in pV. (Higher numbers are worse.) The information will
dictate whether a good recording from the patient can be obtained. Excessive
interference is often caused by poor electrode contact, so if the interference value is
high, check the electrode contact and re-measure.

3.6.14 Red Background Light

This will turn the background light of the Ganzfeld red. This is meant to help
f assist the technician when placing the electrodes without ruining dark adaptation
of the patient.

3.7 Creating Reports

3.7.1 Selecting Patient’s Data

The first step in generating a report is to select the waveforms that will be displayed.
From the main menu, go to Create Report. EMWin will put up a Patient Information
Screen to fill in and search through the waveforms with. The more filled in, the fewer
waveforms that must be searched through to find the desired ones.

In the Action window, View Waves is selected as default, allowing the waveforms to be
displayed in order to create the reports. Export Waves and Export Cursors will be
discussed in the export data section 10.9.2.

Information
Last Name Record # -
First Name Start Number -

Middle Initial Diagnosis

Identification
Sex

Birthdate Friday , March 15,2019 ¥ Action

Age Range To - Years
Test Date Friday , March 15,2019 ~ RO Friday , March 15 2019 =

Other

Test Type
=y

0 View Waves

@ Export Waves

Patient Information Screen

In many cases, filling in the patient’s last name will be sufficient to search through the
large database.
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Filling in the Age Range as 45 - 55 would select all patients aged 45 to 55. Note that
this computes the age of the patient at testing, not the present age of the patient.

Filling in Test Date as 11/1/1990 - 11/30/1990 would select all tests performed in
November, 1990.



UTAS EMWIN

Any menu item which is left blank is assumed to match all items. As an example, to find
the ERGs of all patients named Smith who were tested in July of 1990, fill out the menu
as follows:

Last Name : Smith
First Name

Middle Initial
Identification

Sex

Birthdate

Age Range :

Test Date : 7/1/1990 - 7/31/1990
Other :

Test Type . ERG
Record Number:

Start Number :
Diagnosis

If EMWin reports No Matches Were Found, either the name was either misspelled in the
search or the patient name may have been mistyped when the test was performed. Itis
also possible that the waveform is stored in a different database or has been deleted.
Use wildcards (*) to help reduce errors. For example, the search term: Sm* will find
"Smith", "Small", "Smythe," etc.

EMWin will search through all of the waveforms and display on the screen all of those
that match the items filled in on the menu. Select the waveforms to display by clicking
anywhere on the line of the appropriate waveform. If a mistake is made, click on the
box again to deselect it.

Notice the list of waveforms in the “Search Results” box. The waveforms that are
selected will be displayed on the next screen.

3.7.2 Selecting the Display View

Once the search parameters have been entered, the search result box will appear as
follows:
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Search Results

Left-Hand Graph

Date Label Name Actions

k=l
L 1
k3 2
L 2
R 3
L 3
R 4
L 4
L 5
o: . Pattern 1
. Pattern 1
1
1
1
.3
3
4
4
100% Cont. Pattern 1
100% Cont. Pattern 1
2 Hz 1

Total Records:
=

It has two main windows that contained the data waveforms. Left-hand Graph refers to
the left half page of the report; Right-Hand Graph refers to the right half page of the
report.
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There are two different ways to display the data:
Option 1: Select waveform 2 (in this case L eye ERG) in Left-hand Graph and
waveform 1 (in this case R eye ERG) in Right-hand Graph then the data will
display as below.

LKC Testing Verification * Test Report * 224 Test Avenue * Gaithersburg, MD 20879

Printed: 10:58:12 AM Tuesday, December 17, 2019
Database: C:\EMWIN\R27SWTESTING.MDB

Record 4 Record 5
Extenced ERG I o Extended ERG
= Scotopic White 1 dB Flash - Scotopic White 1 dB Flash
Patient R17 Patient: R17
Tested: 2019/11/04 - Tested: 2019/11/04
Leiil BN ng ms - Ny ms
2-1 -2142 120 100 2-1 -2308 125
4-3 3565 325 - 4-3 4130 325
. -
o
00— 1001+
o | ., -
= = L
T e -
-aco-+-
~a004-
—aco--
~aco-4- -
B 500
-so0— -
........ I A A A R A
o 100 =00 o 50 100 150 200
rrillisecorcs rrillisecorss

Option 1
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Option 2: If the two waves are selected in the Left-hand Graph window then they
will appear on top of each other in the report.

LEC Testing Verification * Teat Beport * 224 Teat Avenune * Gaithersburg, MD 20873

Printed: 10:59:14 AM Tuesday, December 17, Z019%
Database: C:\EMWIN\R27SWIESTING. MDE

MJ -
L 1 m
n: {F qu\ / mhm\_\
S- : '\\I arjll
3 mf )
A
- !
At M
1
B A
Y AQ*J\\ / kﬁ,__\ﬁ
~ 8 Wi/ |
> - i \
N N /
m: = /
:I ] I I | I | 11 I | | i M\V\lel‘/r I |
0 1] 1 51} a0
millseonds

MNaveform 1: Extended ERG: Scotopic White 1 dB Flash
MNaveform 2 Extended ERG: Scotopic White 1dB Flash

Waveform 1 Waveform 2

Record # 0004 5
Test Date: 2018/11/04 2018011/04
Time: 01:32 PM 01:32 PM

Graph is: Average 1of 1 Average 1 of 1

High pass‘x'l-z:l: o= 0.3 o= 0.3
Low pass (Hzk: 500 500
Moich Filter: ON oM
Background: OFF OFF
Amp. Time Amp. Time

Cursor 1: 108 30 105 3.0
Cursor 2: -203.3 15 -2204 155
Difference -2142 120 -230.9 123
Cursor 3: -203.3 15.0 -2204 155
Cursor 4: 1532 475 187.5 480
Differance 3365 323 418.0 325

Option 2
Both options have advantages and inconveniences.

In option 1, up to 5 waveforms can be selected on each side, but the waveforms will
appear a lot smaller since it is only using half of the page.

In option 2, the waveforms are more visible because they are using the whole width;
however, there is a maximum of 5 waveforms that can be displayed with this option.



UTAS EMWIN

3.7.3 Adjusting the Data Display

There are several things that can be done to adjust the display of the data on the
reports. Along the right and left time axis, the waves can be zoomed in on. (see

example below)

To adjust the time scales (for
display purposes only) first
click on the waveforms and
then move the Xmin and ;
Xmax tabs to the desired &
location.

The gain buttons allow the
user to zoom in and out in
amplitude. To change the
amplitude of one curve and &
have the second one match:

Select one of the waveforms,
adjust the gain and click on

the =l icon. This will set all
waveforms  currently  on
display to the same amplitude scale.

The position buttons allow the user to move
the waveforms up and down on the displays.

3.7.4 Retrieving data

Once the first report is done, use the retrieve
menu to select the next waveform to avoid
going back to the main menu. See section
10.6.5 about the retrieve menu.

3.8 User-Defined Protocols (UDP)

3.8.1 Creating user-defined
protocols

To write a User-Defined Protocol, choose
Design Protocols and choose Design from
the Main Menu. The option of writing a new
protocol, editing an existing User-Defined
Protocol, deleting a protocol, or printing out a
summary of a protocol will appear.

ISCEV 5-Step ERG

PA 0.01 ERG

#| User-Defined Protocol: Main — O >

Create New Protocol Create Protocol From

Select a Protocol:

To create a new protocol, click on CREATE NEW PROTOCOL. To create a new
protocol that closely resembles one already existing, click the protocol you want to
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clone and choose CREATE PROTOCOL FROM. This will copy all the information from
the selected protocol and with the opportunity to make changes to it.

If creating a new protocol, then the screen below will appear. This screen is used to
enter the Protocol Name, Test Type, and Stimulator Type.

The Protocol Name must be unique or the device will ask to replace the existing file.
At this time, ERG and VEP are the only available options for Test Type. Only the
stimulators that the equipment is configured for will be offered as choices under
Stimulator Type. The other stimulators will be grayed out. Depending on which
stimulator is used, the appropriate parameter window will open. See section 10.6.1 on
parameters. Be sure to check all 4 tabs and select the values desired (stimulator
parameter, amplifiers, timeframe and averaging).

Note: All flicker stimuli should have a pre-stimulus baseline of 0 in the
timeframe tab

Once all the tabs for the first step of your protocol are checked, click continue, and the
choice to add another step or finish the protocol (which would create a one-step
protocol) will come up. If add another step is selected, the software will automatically
use the values selected in the previous as default.

Edit a Protocol

3.8.2 Editing user-defined protocols
UDPs can edit any user defined protocols by
going to Design Protocol -> Design selecting Add a Step
the protocol to be edited and clicking on Edit.

The choices given are to add, edit, insert or Edit Step
delete steps.

Insert a Step

3.8.3 Using user-defined protocols

To use the UDP that has been created, go to
Perform Test -> User Defined Protocols and
select that protocol from the list.
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Electro-retinogram 3
Electro-occulagram

Visual Evoked Response  »

User-Defined Protocol * TEST-01

3.8.4 Changing Standard Protocols

EMWIN comes with a preset number of ISCEV standard protocols such as On/Off,
standard, double flash, etc. It is possible to change those protocols to fit the specific
clinic’'s needs using the methods described above.

The standard protocols are stored in C:\EMWIN and have .PRO extensions. See
Appendix 3 for the list of all standard protocols, their names and parameters. If the
settings of a standard protocol are changed, the extension of the protocol file must also
be changed from, UDP to.PRO. The protocols will then be able to be edited as
described in section 10.8.2. Once done editing the protocol, don’t forget to change the
extension name back to .PRO

3.8.5 Printing Standard and User Defined protocols

To print protocols, go to Design Protocol -> Print. A list of protocols will appear. The files
with UDP extensions are the user defined protocol, the .PRO are the standard
protocols. All the UTAS protocols have a capital U as the last letter of their name such
as stdergU.pro for the standard ERG.
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SunBurst / BigShot Error Sounds

SunBurst and BigShot have a built-in speaker. It will play music when it is first turned
on. There are some occasions where the Ganzfeld might emit sounds.

Ganzfeld Sounds and Meanings:

1. Ganzfeld is playing the Jeopardy theme song “Think”. This means the
Ganzfeld is overheating. SunBurst will keep playing the music and not
respond to any other commands until the temperature goes down enough.

2. Single Beep. This indicates a wrong command was sent to the Ganzfeld.

3. Two Beeps. The two-beep scheme is used to signal that the flash or
background light that is commanded is either out of the possible color or
luminance range.

— Short Beep of Medium Frequency followed by Short Beep of
Higher Frequency: Color out of bound

Long Beep of Medium Frequency followed by Short Beep of
Lower Frequency: Luminance out of allowed range

Viewing Sty >
3.9 Other Features Ewing SYIE

Border Style ¥

3.9.1 Exporting Images il ’

Exporting the patient data for analysis or visualization in | ¥ ShowLegend
other programs is very simple. When a graph of data is Data Shadows y
on the screen (either in Test Mode or Report Mode), Grid Options >
click anywhere on the background of the graph (left side Mark Data Points
or right side) with the right-mouse button. A pop-up
menu will appear with a list of features. Select the item Maximize...
labeled  “Export Dialog” and the  Exporting Customization Dialeg...
Electroretinogram window will appear. Export Dialog...

The picture can be exported in Metafile or Bitmap format to the Clipboard, a specific file
of the user’s discretion, or the printer.
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3.9.2 Batch Exporting Waveform Data and Cursors

o Exporting Standard ERG x
EMWIN has the capability
to export up to 1000 | Exwot

waveform and cursors of | @glME OwmF  OBMP  CJG  OFNG (O Text / Data
1000 waveforms into a

.CSV file format.

Export Destination
(®) ClipBoard

In order to export the O e

waveforms, Cursor, and | O Printer
patient information into

. ) Export Size
this type of file, go to (®) Milimeters (O Inches () Paints
Report and select EXpOI’t Width: |152.400 4 (101.600 Millimet
Waves in the Action dth: | |/ | | Milmeters [ Epot ]

window. DFt: (] Large Fort Cancel

Informaticn

Last Name Record #

First Name Start Number

Middle Initial Diagnosis

ldentification

Sex

Action

Birthdate Friday , March 15,2019 -

Age Range
D View Waves

Test Date Friday , March 15,2019 - |[UM Friday , March 15,2019 ~

# Export Waves
Other

Test Type
==

Then click on Continue, this will bring up the list of all waveforms.
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Search Results

Left-Hand Graph

Stimulus Name 0 Actions

Cont. Pattern
/13 Cont. Pattern
2/13 0Oz -R Sc cdes/ z rie Fl. 1

Right-Hand Graph

1/14 R

1/14 R

0 Cont. Pattern

00% Cont. Pattern Smi

Use the Ctrl or Shift key to select multiple waveforms to export. The default name of the
export file is Export.CVS. If needed, the name can be changed by typing the desired
new name in the Export File Name window.

Once Continue is clicked, the export file will be created and saved under
C:A\EMWIN\Export.

Note: if multi-data (created a protocol where in one step the software will automatically
collect more than 1 waveform and save all individual waveforms) are recorded, all the
waveforms will be exported back to back; however, only the cursors on the first
waveform will be exported.

3.10 Adaptation Steps

EMWin has introduced the creation of adaptation steps in built-in and custom protocols.
These adaptation steps enable users to track the length of dark adaptation and light
adaptation of subjects using separate software enabled steps.

The adaptation steps will be labeled as such in the test step info:

STEP #1 of 7: Dark adapt {20 min)

Database: 980VERFICATION
Proto ergl

When the user selects to start the test, the software will prompt the user to begin the
adaptation step:
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| Select OK to start dark adaptation

QK Cancel

Once the adaptation step begins, a timer will appear allowing the user to track the
adaptation step.

#® Data Acquisition d

Adaptation Time Remaining:

19:56

The adaptation timer will allow the user to select whether to pause the timer, restart the
timer, or exit out of the adaptation step. If the user is performing an auto-run protocol,
the timer will also allow the user to skip over the adaptation step.

Built-in ISCEV protocols will contain the adaptation steps for Dark Adaptation, and Light
Adaptation. These will be automatically included for users. These adaptation steps are
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also available through custom protocol design. The adaptation control panel is shown
as a separate step. Seen below:
User-Defined Protocol

Protocol Name:
Test Type
© ERG ® VEP

Test Step Type
© Flash
@ Double Flash
@ Flicker

@ On/Off

@ Dark Adapt

@ Light Adapt
@ Pattern

@ Trigger Input

Users are able to select dark adapt or light adapt.

Dark adaptation design:
e Users are able to choose how long a duration the dark adaptation timer records
e Users are able to prompt users prior to the start, or at the end of start
e Users are able to enable whether skipping or early stopping of adaptation is
available during recording:
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SunBurst Flash

LLUTL I Dark Adaptation -

I” Pause at Start
™ Pause atEnd

[~ Allow Early Termination

Light adaptation design:

e Users are able to choose how long a duration the light adaptation timer records
Users are able to select the color of the background adaptation light
Users are able to select the luminance of the background adaptation light
Users are able to prompt users prior to the start, or at the end of start
Users are able to enable whether skipping or early stopping of adaptation is
available during recording:

LSV CU | ight Adaptation o

Duration (seconds): |0

I Pause at Start
I Pause at End

[~ Allow Early Termination

dB-cd.s/ "
off Low Middle | High Bright
10 = dB =0.250 cd.s/m*
intensity (Oto 5000 cd/m?). 0

Color.

}.
i 3

ik

@ White " Amber (" Ultra-Violet InfraRed LED

© Red Green { Blue ¥ on

" Custom Color X [0483 Y [0.404

3.11 Automated Testing

EMWin has introduced automated protocol testing. This feature enables the end user to
perform an entire protocol with the push of a button. All built-in protocols or custom
protocols have this feature. The automated testing button will be found in the toolbar at
the top during the start of each test. This is shown with the following icon:

®

This icon allows the user to start the autorun feature in EMWin. Once selected, the
following actions will occur:
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e |If the protocol has an adaptation step, the automated protocol will first prompt the
user to start the adaptation timer. As shown below:

| Select OK to start dark adaptation

K Cancel

¢ If the protocol does not have an adaptation step, the protocol will go through
each step in the protocol automatically. The automated test protocol will
automatically save files as dictated by the protocol.

¢ If performing scotopic tests, the automated test feature will include a time delay
in between each step to prevent unintended light adaptation, set in a custom
protocol by the Post-Step Dark Adapt Recovery parameter.

SunBurst Flash I Averaging ] Amplifiers ] Timebase ]

Test Type  [single Flash -

1st Flash
Stimulus Source
+ LED " XENON

Intensity(dBj: -30

Calor
' White " Ultra-Violet
" Red " Green " Blue

" Custom Golor

X jozes Y [0.318

™ Backaground Light Fixation light
* Off dB- cd.sim® Converter

¥im 30 = e =0.003 ed s/m*

" Bright
2500 H  cdsme -0 dB

InfraRed LED
™ on

Post-Step Dark Adapt Recovery (s) 30

e Users may interrupt the autorun feature which will cancel the current step and
require the user to repeat that specific step. Autorun will not automatically
resume unless it was been chosen again.

EM for Windows *

Test cancelled before all steps completed.

o]

e The autorun feature is designed for nonstop continuous testing. It is best
implemented for research purposes in subjects under anesthesia. It may also be
appropriate for highly cooperative patients.
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4 |Introduction

This portion of the User's Manual contains instructions for testing patients with LKC's
UTAS. The manuals for hardware and software components of the device should
already be understood. This section will focus only on how to use the instrument to test
patients

5 The Electroretinogram (ERG)

5.1 Overview

The electroretinogram (ERG) exposes the patient to some visual stimuli and measures
the electrical response of the retina. The most commonly used stimuli are a flash of light
(either bright or dim) or an alternating pattern of light flashes.

In clinical testing, the electrical response of the retina is measured by placing one
electrode on the cornea and a second electrode on a reference location, usually the
forehead, and measuring the electrical difference between the two. This difference is
measured by a sensitive amplification system which can detect millionths of a Volt
(called microvolt, and abbreviated as pV). In contrast, a typical wall outlet produces
more than 100 Volts, more than a million times greater than the typical ERG signal.

Typically, ERGs are performed with a flash of light that covers the entire retina. To
ensure that this happens, a device called a Ganzfeld is used. A Ganzfeld is a device
that resembles a bowl covering the patient’s vision field and is coated with highly
reflective paint. The flash of light stimulus evenly illuminates the interior of the Ganzfeld
and allows the most penetration of light into the patient’s eye.

The flash ERG can be used to separately measure the response of the retinal rods and
cones. The response of the rods is measured by first dark adapting the patient and then
stimulating the eye with dim flashes of light. Using a bright flash of light tests both the
rod and cone response. The rod function is suppressed when the patient's eyes are
exposed to an adapting light so that only the response of the cones is measured.
Rapidly flickering lights is also used to measure cone function. The most commonly
used flash ERG test is the "standard ERG" which encompasses all of the above tests.

Other types of ERGs include the multifocal ERG (measures the function of the macula)
and the pattern ERG (measures the function of the inner retinal layers, including the
ganglion cells). The Standard ERG is the most commonly used, so we will focus on it
for most of the section while also mentioning some of the other types.

5.2 ERG protocols

If the device contains a mini Ganzfeld with the SunBurst or BigShot, some of the
protocols will be the same; such as the Standard and Standard with Mini-Ganzfeld
protocols. The only difference is the instrument used to deliver the stimuli and the fact
that with the mini-Ganzfeld unit, it is possible to only test one eye at a time.



5.2.1 ISCEV 5 Step ERG Protocol

Testing the Patient

This protocol currently recommended by the International Society for the Clinical
Electrophysiology of Vision' (ISCEV); they explain:

The rod response is particularly useful to determine hereditary night-blinding disorders
as well as conditions that involve peripheral retinal function, such as diffuse
The cone response is used to diagnose cone dysfunction in
hereditary or acquired disease. Flicker responses document ERG timing that can help
diagnose vascular disease or discriminate between dystrophies and acquired
The maximal response provides an overall indication of the retina
function and can be used to diagnose conditions such as traumatic retinal damage or
evaluate visual impairment in infants. The oscillatory potentials are used to determine

inflammatory disease.

degenerations.

In 1989 a basic protocol was standardized so that ERGs
could be recorded comparably throughout the world. This
standard was updated most recently in 2008. Standards for
five commonly obtained ERGs were presented: (1) ERG to a
weak flash (arising from the rods) in the dark-adapted eye
(2) ERG to a strong flash in the dark-adapted eye (3)
Oscillatory potentials (4) ERG to a strong flash (arising from
the cones) in the light-adapted eye (5) ERGs to a rapidly
repeated stimulus (flicker)

disorders that cause retinal ischemia, such as diabetic retinopathy.

ERG Conditions - Standard Protocol:

1 | Scotopic | Single Flash -24 dB | 0.01 cd/m? Rod Response

2 | Scotopic | Single Flash 0dB 2.5 cd/m? Maximal Response
3 | Scotopic | Single Flash 0dB 2.5 cd/m? Oscillatory Potentials
4 | Photopic | Single Flash 0dB 2.5 cd/m? Cone Response

5 | Photopic | 30 Hz Flicker 0dB 2.5 cd/m? Flicker Response

Unless specified otherwise in the protocol, 10 sweeps will be averaged for 30 Hz flicker

(stimulus condition 5).

20 minutes of dark adaptation is required in the
Standard Protocol prior to any stimulation

1 International Standardization Committee. Standard for clinical electroretinography (2008 update). Documenta
Ophthalmologica 118: 69-77, 2009.
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5.2.2 ISCEV 6-Step ERG Protocol

In the 2008 update of the ISCEV Standard for full-field clinical electroretinography, it is
recommended that an additional flash is performed while the patient is dark adapted.
This flash stimulus is called the Dark-adapted 10.0 ERG and occurs after the standard
step 3 in the protocol at an intensity of 6dB. The purpose of the additional gives is to
produce a response with a larger, more defined a-wave and identifiable oscillatory
potentials. The more intense stimulus can also be useful for eliciting a maximal
response from patients with denser opacities who would normally not be able to
produce the response to step 2.

1 | Scotopic | Single Flash -24 dB | 0.01 cd/m? Rod Response

2 | Scotopic | Single Flash 1dB 3.0 cd/m? Maximal Response

3 | Scotopic | Single Flash 1dB 3.0 cd/m? Oscillatory Potentials

4 | Scotopic | Single Flash 6 dB 10.0 cd/m? Larger a-wave Response
5 | Photopic | Single Flash 1dB 3.0 cd/m? Cone Response

6 | Photopic | 30 Hz Flicker 1dB 3.0 cd/m? Flicker Response

5.2.3 ISCEV 4-step ERG protocol

In the 2022 update of the ISCEV Standard for full-field clinical electroretinography, an
abbreviated 4-step protocol was introduced as a possible clinical option. This protocol
performs the light adapted portion first, following by an abbreviated dark adaptation
period of 5 — 10 minutes. Then the dark-adapted portion is performed.

1 | Photopic | Single Flash 1dB 3.0 cd/m? Cone Response

2 | Photopic | 30 Hz Flicker 1dB 3.0 cd/m? Flicker Response

3 | Scotopic | Single Flash 24 dB | 0.01 cd/m? Rod Response

4 | Scotopic | Single Flash 6 dB 10.0 cd/m? Larger a-wave Response

5.2.4 Classic ERG Protocol

Until the adoption of the Standard Protocol by ISCEV, the Classic Protocol was the most
commonly utilized ERG diagnostic protocol. It also consists of 5 steps, as follows. (1) The
Scotopic Blue stimulus. Since rods are more sensitive to short wavelength light (blue),
this step isolates the rod response. (2) The Scotopic Red stimulus, displays both the rod
and cone response on a single waveform. Interpretation of this waveform may be
difficult. (3) The Scotopic White stimulus provides a maximal response of both the rod
and cone systems. This is the same stimulus as step 2 of the Standard Protocol. (4)
The Photopic White stimulus is designed to suppress rod participation. This is the same
stimulus as condition 4 of the Standard Protocol. (5) The 30 Hz Flicker stimulus isolates
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the cone response because the flicker is too fast for the rods to follow. This stimulus is
done without background light.

ERG Conditions - Classic Protocol

1 | Scotopic | Single Flash | Blue - 38 dB | 0.0004 cd/m®* | Rod Response

2 | Scotopic | Single Flash Red +8 dB | 16.0 cd/m? Rod+Cone Resp.
3 | Scotopic | Single Flash 0dB | 2.5cd/m? Maximal Response
4 | Photopic | Single Flash 0dB | 2:5cd/m? Cone Response

5 | Photopic | 30 Hz Flicker 0dB | 2.5cd/m? Flicker Response

Unless specified otherwise in the protocol, 10 sweeps will be averaged for 30 Hz flicker
(stimulus condition 5).

30 minutes of dark adaptation are required in the
Classic Protocol.

5.2.5 Bright Flash ERG Protocol

The Bright Flash protocol presents a stimulus that is much brighter than the intensity of
the standard flash. It is normally used for subjects with sufficiently dense media over the
eye that the standard flash cannot elicit a response from. The Bright Flash protocol
should not be used to attempt to elicit a larger response from subjects with relatively
normal media (unless attempting to determine the asymptotic pi, amplitude, or measure
the photoreceptor kinetics). The Bright Flash Protocol may also be used to elicit
oscillatory potentials. If the Bright Flash receives maximum amplitude Ops, use a
conditioning flash followed by the recording flash 30 seconds later.

When testing a subject with one relatively normal eye and one with opaque media, the
normal, dilated, eye should be patched to prevent severe discomfort from the bright
flash stimulus.

5.2.6 Photopic Negative ERG Protocol

The photopic negative response (PhNR), originating from the inner retina, appears after
the b-wave (and if the flash duration is long enough, it appears again after the d-wave).
The PhNR arises as a consequence of the spiking activity of the retinal ganglion cells.
PhNR may be a sensitive measure of retinal dysfunction in patients with diseases that
affect the inner retina such as glaucomatous damage.

The photopic negative response is elicited using a 200 ms red (630 nm) stimulus with a
blue background (470 nm).
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PhNR ERG

1 BLU Photopic, Red 8 dB Flash

100
milliseconds

5.2.7 S-Cone ERG Protocol

S-Cone ERGs facilitate the determination of enhanced S-cone syndrome, a rare
disorder related to mutation in NR2E3. By enabling a more detailed assessment of the
relative involvement of S-cones in other genetically determined disorders, they
contribute to a more accurate description of the phenotype.

S-Cone recording requires a bright photopic background to suppress the rod and L-
cone and M-cone function. The typical protocol uses a blue flash (470 nm) on a bright
amber (590 nm) background.
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S-Cone ERG

AMB Photopic, Blue -10 dB Flash

5.2.8 On/Off Response

The L- and M- cones cells signal via both ON- (depolarizing) and OFF- (hyperpolarizing)
bipolar cell pathways. Rods do not communicate with OFF- bipolar cells, and no S-
Cones OFF bipolar cell have been identified. Long duration stimulation enables the
functional separation of the cone ON- and OFF- responses.

ON- and OFF- response recording enables an assessment of the post-
phototransduction cone pathways. This may reveal abnormalities not usually indicated
by a more conventional cone ERG protocol and may therefore contribute to an accurate
determination of the site and nature of the cone system dysfunction. This knowledge
may help in the management of both inherited and acquired retinal disease.
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On/Off ERG

WHT

5.2.8.10N/OFF custom protocol design.
There are two methods of creating an ON/OFF protocol in the custom design.
1) Integrate on/off

The first method is to design the protocol with the intent that there is an always-

on background light and the stimulus is presented on top of the background. As
seen in the image here:

Test Type OnlOff Response

ONOFF: STEP #1

Users can select a on flash luminance as well as the time. The background light
can also be selected. Both background and long duration flashes will be
combined during the flash duration. This method, for exmaple, enables stimuli

such as a green background (“off” phase) and a cyan (green+blue) “on” phase.
2) Replace off/on
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The second method is separately specify the lighting during the “on” phase and
the “off’ phase. This method, for example, enables stimuli such as red light
during the “on” phase and green light during the “off’ phase or a dim white light
during the “on” phase and a bright white light during the “off” phase.

On/Off Method

" Integrate On and Of

* Replace Off with On

This allows the user to select separate stimulus conditions during the long flash
on duration period, and during the off flash duration.

5.2.9 Flicker ERG Protocol

The flicker ERG protocol is one that measures cone response by presenting a flickering
stimulus that is too fast for rods to respond to. The protocol presents flickering stimuli
at 5, 10, 15, 20, 25, 30, 35, and 40 Hz. Itis used mostly in research investigations.

5.210 Pattern ERG Protocol

This protocol uses an alternating checkerboard pattern to elicit a retinal stimulus, unlike
the flashing light stimuli in other protocols. Because equal amounts of the retina are
stimulated as the checkerboard alternates, the response is a measure of neuron and
ganglion cell activity of the inner retina rather than the rod and cone activity. As such,
the pattern ERG is useful in diagnosing inner retina disorders.

The pattern ERG is a photopic test, so dilation and dark adaptation are not necessary.
Because the edges of the checkerboard are important components of the stimulus, any
refractive error should be corrected. If cycloplegic drugs are used, a one diopter plus
added should be used to compensate for the typical screen distance of one meter.
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Pattern ERG

32x32 25 arc-minutes 100% Contrast Checks 4 Hz

150

milliseconds

5.2.11 Double Flash ERG Protocol

The double flash protocol is used to study the recovery of photoreceptors. It consists of
a bright conditioning flash followed by a measurement flash. The amplitude of the
measurement flash as a function of time will provide the information needed. The
recovery time of the photoreceptors, such as between the two flashes, is affected in

several retinal disorders including retinitis pigmentosa.
Double Flash ERG

]
R

DoubleFlash: , , 150 ms

0 50 100 150 200 250 300 350 400 450 500
milliseconds
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5.2.12 Retinal Ischemia Monitor (RIM) Protocol

The RIM protocol can be used to assess ischemic retinopathies such as Diabetic
Retinopathy, Ocular Ischemic Syndrome, Central Retinal Vein Occlusion (CRVO),
Branch Vein Occlusion (BVO), Central Retinal Artery Occlusion, and Sickle-Cell
Retinopathy. RIM has been shown to be 92% accurate in predicting the outcome in
CRVO and has a strong correlation to the severity of Diabetic Retinopathy.

Retinal Ischemia Monitor

B
R

Amp.: 93.3 pV, L.T: 249 ms

Scotopic Flicker30 Hz

150
milliseconds

5.3 Patient Preparation

5.3.1 Standard ERG

The first step in the standard ERG is to dilate the patient's eyes with a mydriatic (any
medium-duration cycloplegic, such as Tropicamide, will be sufficient). If the patient is
already dilated from ophthalmoscopy, no further dilation is required. It is more
comfortable for the patient if a few drops of local anesthetic are administered to the eye
before the mydriatic dilating drops.

The next step is to dark adapt the patient. This step is critical to obtaining good
results. The patient should be dark adapted for at least 20 minutes before the test is
administered (dark adapting for longer than the 20 minutes will not alter the results, but
dark adapting for less than 20 minutes will create problematic responses). To dark
adapt the patient; simply place them in a completely darkened room (such as the room
in which you will perform the ERG). Another method to dark adapt the patient is to
securely patch the patient’s eyes so that no light can get through and return them to the
waiting room.
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After the patient has been dark adapted for at least 20 minutes, they should be brought
into the testing room. The testing room must be completely dark (a dim red light is
acceptable which may be provided by the Ganzfeld’s background red LED if needed)

5.3.2 Pattern ERG

For the pattern ERG protocol, do NOT dilate the patient’s eyes, as the patient must be
able to focus on the pattern stimulus (dilation paralyzes the patient’s ability to focus).
The patient should not be exposed to bright lights, such as sunlight or a slit lamp, for
at least 10 minutes before testing. Use the patient’s best lens correction while running
the test (with either the patient’s glasses or trial lenses).

5.3.3 MultiFocal ERG

Dark adaptation is not required for the multifocal ERG protocol because it tests only
cone function. However, the patient should not be exposed to bright lights, such as
sunlight or a slit lamp, for at least 10 minutes before testing.

It is best to perform this test with the eyes dilated; although it doesn't largely affect the
test results, it will make the technician’s job much easier. To dilate the eyes, apply a
cycloplegic agent and allow the patient to sit for about 15 minutes for the drug to take
effect. If the patient is already dilated from a previous procedure, no further dilation is
needed.

This test is only available if you have the multifocal ERG upgrade.

5.3.4 Other ERGs
There are several other types of ERGs, such as the intensity-response ERG, the flicker
ERG, and the bright flash ERG. All of these tests require dilation of the eye and dark
adaptation (the exception to this is if the eye to be tested is damaged by trauma in
which a cycloplegic may be contraindicated). After applying dilating drops in the eye,
dark adapt the patient for the amount of time shown in the table below.

Dark Adaptation Period for Various ERG Tests

ERG Test Dark Adapt Time
Standard 20 minutes
Intensity-Response 45 minutes
Flicker 10 minutes
Bright Flash 20 minutes

5.4 Electrodes (Type BF Applied Parts)

& Note: The instructions below related to anesthetization, insertion and
removal of corneal electrodes, and post testing eye cleaning are provided as a
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general aid. Follow your clinic’s procedures and guidelines for these procedures
as well as adhering to the manufacturer’s use instructions.

After the patient has been dilated and dark adapted (if needed), the next step is to
attach the electrodes to the patient. All ERG tests require three different electrode
connections; the corneal electrode, the reference/indifferent electrode, and the ground
electrode. Use only electrodes enumerated in Appendix 1 of the UTAS Hardware
manual.

Note: If the protocol requires that the patient be dark adapted, the electrodes
must be applied in the dark room, lit with only a dim red bulb (the
Ganzfeld’s dim red background light may also be used).

To apply the electrode, anesthetize the cornea with several drops of a medium duration
anesthetic, such as proparacaine hydrochloride (do not use a short-duration anesthetic -
it will wear off before the test is over). While waiting for the anesthetic to take effect,
apply the electrodes to the locations other than the eye.

TICY

5.4.1 The Indifferent/Reference Electrode

The indifferent/reference electrode should be applied first. It is ()
a separate electrode, often an ECG (EKG) electrode, such as \.
the Silvon® electrode. The Burian-Allen electrode has the
indifferent electrode built in (making it a bipolar electrode and
does not require a separate indifferent electrode).

-9

The indifferent electrode is applied to the center of the

forehead and used as a reference for both eyes. With an electrode prep pad, scrub the
center of the forehead to remove all traces of skin oils and makeup. Let the alcohol dry
off for a few seconds. Before the indifferent electrode is applied, check it to make sure
the center gel is still wet (if it has dried out, discard the electrode and get a new one as
it won’t be able to obtain a sufficient signal from the patient).

If you are testing two eyes, connect a splitter to the - inputs of recording channels 1
and 2 of the UBA. (A splitter is a Y-shaped cable with plugs on two sockets and an arm
on the third.) Connect the indifferent electrode to the splitter.

5.4.2 The Ground Electrode

The ground electrode, typically a gold cup ear clip
electrode, should be applied after the indifferent
electrode.

The electrode is applied to the patient’s ear lobe. With
an electrode prep pad, scrub the ear lobe to remove all
traces of skin oils. Let the alcohol dry off for a few seconds. Fill both cups of the ear clip
generously with electrode gel and clip it onto the ear lobe. Plug the ground electrode
into the appropriate ground channel of the amplifier.
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5.4.3 The Corneal Electrode

Finally, the corneal electrodes should be applied. The most common corneal
electrodes are the ERG-Jet, Burian-Allen, and DTL electrodes (shown below). Other
types of electrodes may be used.

ERG-Jet Electrode Burian Allen DTL Electrode

Contact Lens Electrode

Before inserting the contact lens electrodes, place several drops of a lubricating solution
that contains methylcellulose (such as Goniosol or Liquid Tears) in each of the contact
lens electrodes. If you are using the ERG-Jet electrodes or the Burian-Allen electrodes,
Liquid Tears may minimize damage to the cornea.

Gently insert a contact lens into the eye. Leave a small loop of excess electrode wire
(about 1" - 2" in diameter), and tape it to the patient’'s cheek. Repeat the procedure for
the other eye, if appropriate.

DTL Electrode

DTL Electrodes are used with patients that cannot tolerate the ERG-Jet contact lens
electrode. They are single use, silver nylon thread electrodes. They should be placed
on the eye so that the fiber is running gently across the cornea (not too tight to avoid
corneal abrasion).

Gold Foil Electrode

The gold foil electrode is used to avoid blurring the patient’s vision, where contact lens
use is not possible (such as in eyes with keratoconus), or where topical anesthetic is
not desired. The gold foil electrode has a thin coating of gold deposited onto a Mylar
substrate.

To insert the electrode into the patient’s eye, fold the electrode in half lengthwise with
the foil side out, so that it forms an inverted “V”. Gently retract the patient’s lower lid
and insert the end of the electrode into the space between the lower lid and the sclera.
Tape the electrode wire to the patient’s cheek to hold the electrode in place.
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Note that blinking or rapid eye movements easily dislodges the gold foil electrode. It is
important that the patient looks straight ahead and does not blink excessively once the
electrode has been inserted.

Always connect the corneal electrodes (active electrode) to the + input of each channel
and references to the — input of each channel of the UBA. Connect the ground electrode
into the ground channel.

Splitter

Ground

Monopolar Electrode Placement (ERG-Jet, DTL...)



Testing the Patient

Bipolar Contact Lens Electrode Placement

5.4.4 An alternative to Corneal Electrodes

In 2014 LKC introduced Sensor Strip electrodes for visual electrophysiology
measurements. Sensor Strips are adhesive, skin contact, electrodes which include the
three necessary electrode connections and so they can take the place of all three of the
electrode types mentioned above. Sensor Strips are single-use so there is no cleanup
of messy electrode gels or pastes. For optimal use the skin below the eye should be
prepared with a pre-electrode attachment cleaning method. LKC recommends use of
Nuprep or a similar product. Signals collected using Sensor Strips will be of smaller
magnitude than corneal electrodes, this should be considered before use.

LKC Sensor Strips are intended for human use only.

One Sensor Strip to DIN connector cable (LKC # 91-201) is provided with all SunBurst.
Two cables are required for binocular testing.
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Bipolar Contact Lens Electrode Placement

1-

1+

Ground
2_
2+

Sensor Strip Electrode Placement
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5.5 Recording Data

After the electrodes have been inserted, the test may be started. The patient
information may be inserted into the program before the electrodes are placed on the
patient to minimize the amount of time the patient must have the electrodes inserted
and to speed up the total testing time.

In this section, the Standard ERG protocol will be used. Other protocols are very
similar. In order to understand this section, familiarity with the UTAS Software
manual is necessary.

5.5.1 Setting up the test

¢ From the main menu select Tests -> Electroretinogram -> Standard

¢ Fill in the patient information (see section 10.5.2 for more info on the patient info
window) and click on Continue

¢ Select the number of channels to be used and label them. Label the channels
with the eye to be tested. If testing both eyes, select two channels (the
convention is to have Channel 1 labeled as Right Eye and Channel 2 as Left).

You are now ready to start the test. Be sure the patient is seated comfortably with their
face in the Ganzfeld. Instruct the patient to look straight ahead at the red light.

5.5.2 Record — Checking the baseline

Click on Record (which is the first icon of the toolbar). The baseline is a check to

make sure that everything is working correctly; that the electrodes are connected
properly and making good contact with the patient, that the patient isn't clenching

their face muscles, that no power line interference (maybe from the laser next door) is
being detected, etc.

An example of a poor baseline is shown below. This baseline has a large amount of
power line interference in it. If the baseline looks similar to this one, suspect a bad
connection in the device. The indifferent electrode may not be making good contact with
the forehead or there may be a problem with the contact lens electrode. Of course,
there are other potential sources of interference as well. For more information about
interference see Appendix 2: Artifacts in Electrophysiology in the UTAS hardware
manual.

Also shown below is an example of a good baseline. Attempt to make the baseline as
close to this horizontal line as possible. If the baseline does not look good, if it has a lot
of vertical lines or other noise and occupies most of the screen — it needs to be fix the
problem before continuing with the test.
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Bad ERG Baseline

Good ERG Baseline
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5.5.3 Recording Data
Step 1: Rod Response

At the bottom of the screen there should be a line reading "Scotopic White -24 dB
Flash".

Click on Record (this can be found on the top menu or the record Icon). Once the
baseline is stable, click stop and then click on record. If the response looks good
(examples of good waveforms are shown in the Analysis section below), click on Store
(using the diskette icon). If the response does not look good (at this point, | m
usually because of a blink or other reflex motion), wait at least two seconds | [(5
before repeating the flash.

Note: Always wait at least 2 seconds between dim flashes (if
required) of step 1 to avoid light adapting the subject.

After storing a good waveform, move to the next step. Click on the Step
Forward icon. )

Step 2: Maximal Response

The bottom of the screen should now read "Scotopic White 0 dB Flash".

Again, click on Record to measure a baseline and make sure noise hasn’t developed. If
the baseline looks OK, click Stop and then Record. The response will look different this
time - it will be larger and less rounded. An example of a good response for the second
step in the protocol is shown in the Analysis section below. If the response is good, click
on Store to save the waveforms. If they're not good, wait at least 15 seconds before
trying again to avoid light adapting the patient.

After storing a good waveform from step 2, click the Step- Forward icon to proceed to
Step 3.

Step 3: Oscillatory Potentials

The stimulus description at the bottom of the screen won't change for this step since the
stimulus isn't different for oscillatory potentials, only the recording technique. Again,
click on Record to make sure no noise has developed.

To record oscillatory potentials properly:
¢ Click on Record. Do not store this waveform.
¢+ Wait 15 seconds
¢ Click on Record. If this waveform looks good, store it. If not, wait another few
seconds and repeat the steps.
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The first flash is called a conditioning flash. It is used to sensitize the retina to maximize
the oscillatory potentials recorded with the second flash, which is measured to give the
waveform to be stored.

Step 4: Photopic response

When you click on Step Forward to move to step 4 of the protocol, the background light
inside the Ganzfeld will turn on. For this step, the patient needs to be light adapted
using this background light so be sure the patient doesn’t close their eyes for extended
periods. The bottom of the screen should now read "WHT Photopic 0 dB Flash".

Wait 10 minutes for light adaptation before recording.

Repeat the Record, and Store sequence performed above in step 3.

Step 5: Flicker response

This is the last step of the protocol. The bottom of the screen should read "WHT
Photopic 0 db 30 Hz Flicker". Click on the Record button. The remainder of this step is
automated, so the program will automatically start the flash flickering at 30 flashes per
second, waiting 5 seconds, then averaging the 10 sweeps. The result will be displayed
on the screen. To save the waveforms, click Store.

The test is now finished. Click on Return until to reach the Main Menu. ‘m
5.5.4 Cleanup

First, gently remove the corneal electrodes from the patient's eyes. Next, remove the
indifferent/reference and ground electrodes from the patient’s forehead and ear. Use an
alcohol pad or electrode prep pad to remove the sticky material that might have been
left by the electrodes on the patient's skin. The patient is now completed with the test.

5.6 Reports and Analysis
To prepare a report for a specific patient:

¢ Retrieve the patient's waveforms (see section 10.6.5 on how to retrieve
waveforms).

¢ Place cursors on the waveforms or use another method to analyze them (see
section 10.6.9 on how to place cursors using EMWIN).

¢ Print out the reports (see section 10.6.10).

5.6.1 Retrieving the waveforms

In order to retrieve the waveform, go to the main menu and select Create Reports. Fill in
the necessary information to search for the waveforms. For more detailed information
about searching for waveforms, see section 10.6.5
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5.6.2 Step 1: Rod Response Analysis

Retrieve the first two waveforms, labeled "DA 0.01 ERG ”. Next, click on the
Place Cursors icon. Place two cursors on the waveform as shown in the figure Em
below. Place Cursor 1 on a flat spot in front of the waveform and place Cursor 2

at the peak of the waveform (see section 10.7 on how to create report and place
cursors). The calculated difference between cursors 1 and 2 gives the amplitude of the
b-wave. B-wave latency is represented by the timing of cursor 2.

After the cursors are placed properly on both waveforms, click on Store to save the
cursor positions with each waveform.

ISCEV 5-Step ERG

DA 0.01 ERG

DA 0.01 ERG

100
milliseconds

5.6.3 Step 2: Maximal Response Analysis

After storing the cursors with the waveforms, click Return to return to the Reports
Menu. Next, retrieve the following pair of waveforms (either by clicking on
Retrieve -> Next by clicking on the Search For Waveforms icon or by clicking Q
on Next). These waveforms should say "DA 3.0 ERG." Place the cursors as
described below:

Cursor 1 should be placed on a flat spot of the waveform before the amplitude
decreases in the a-wave. Cursor 2 and 3 should be placed on top of each other at the
trough of the a-wave. Cursor 4 should be placed at the peak of the b-wave. If there is
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a small bump at the top of the b-wave, place the cursor to one side of the bump, not
directly on the top.

The calculated difference between cursors 1 and 2 represents the amplitude of the a-
wave, while the calculated difference between cursors 3 and 4 represents the
amplitude of the b-wave. After the cursors are placed properly on both waveforms,
click Store to save the cursor positions with the corresponding waveforms.

ISCEV 5-Step ERG

100
milliseconds

5.6.4 Step 3: Oscillatory Potential Analysis

Retrieve the next set of waveforms that correspond to step 3. These waveforms should
read "DA 3.0 ERG." They will be the recorded measurements of the oscillatory
potentials and will resemble the one shown below.

With this particular waveform, the program will automatically place cursors. Click W‘
on the Analyze Oscillatory Potentials icon or use the menu tool bar and select
Analyze -> Oscillatory Potentials. When the program asks, tell it to place
cursors on the Ops. The results will be similar to the ones on the waveform below.

Note that the cursors placed by the program will not be saved on the original
waveforms; instead, a new waveform with the oscillatory potential cursors will be
created in the database.
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ISCEV 5-Step ERG

DA 3 ERG

100
milliseconds

5.6.5 Step 4 Photopic Response Analysis

Retrieve the next set of waveforms, from step 4, labeled "LA 3.0." Place cursors (and
store them) as dictated below. The Photopic waveform is generally faster and smaller
than the Scotopic waveforms because only cone function is being tested.

Cursor 1 should be placed on a flat spot of the waveform before the amplitude
decreases in the a-wave. Cursor 2 and 3 should be placed on top of each other at the
trough of the a-wave. Cursor 4 should be placed at the peak of the b-wave. If there is
a small bump at the top of the b-wave, place the cursor to one side of the bump, not
directly on the top.

The calculated difference between cursors 1 and 2 represents the amplitude of the a-
wave, while the calculated difference between cursors 3 and 4 represents the
amplitude of the b-wave. After the cursors are placed properly on both waveforms,
click Store to save the cursor positions with the corresponding waveforms.
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ISCEV 5-Step ERG

100
milliseconds
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5.6.6 Step 5: Flicker Analysis
ISCEV 5-Step ERG

LA 30 HZ ERG

Amp): 248 pV, L.T.] 2

LA 30 HZ BRG

milliseconds

Finally, call up the last set of waveforms from step 5. These waveforms will be
labeled "LA 30 Hz ERG " And they correspond to the flicker tests.

To analyze these waveforms, go to the menu and select Analyze ->Flicker
Amplitude and Timing, or use the Analyze flicker icon. This analysis will not N
put cursors on the waveform like the oscillatory potential analysis. Instead, it will
produce a comment display that will contain the amplitude and timing information as
determined by the analysis program.
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THE FOLLOWING ARE STEP BY STEP QUICK GUIDES FOR ERG

May be copied and kept with your device for reference

STEP-BY-STEP INSTRUCTIONS FOR PERFORMING THE STANDARD ERG

Patient Preparation

L4
L4
*

Anesthetize the patient eye(s) to be tested.

Put dilating drops into the eye(s).

Completely patch the eye(s) to be tested or seat the patient in a dark room for dark
adaptation. During dark adaptation no light may get into the eye (a red light, like the
background red light from the Ganzfeld, can be used to see and does not affect dark
adaptation). The patient must be dark adapted for at least 20 minutes.

Computer Setup Before the Patient is Brought for Testing

*
L4
L4

*

Turn the device on and wait for the Main Menu to appear.

On the Menu, select Test -> Electroretinogram. -> Standard.

Enter the patient information. Do not use spaces or punctuation in the data fields, as this
may interfere with the search and retrieval of waveforms.

Add channel information. The right eye is hooked up to channel 1 and should be labeled
OD or R. The left eye gets hooked up to channel 2 should be labeled OS or L. Click
continue

Patient Hook-Up

*

L4
L4

Seat the patient in front of the Ganzfeld globe, clean the forehead with an electrode prep
pad and allow the alcohol to dry.

Turn the red background light of the Ganzfeld on to provide light to place the electrodes.

Place an EKG electrode on the forehead. Connect the pinch connector to the nipple of
the EKG electrode. Plug the pin end of the pinch connector lead into the receptor of the
one-to-two splitter.

Place the two leads from the splitter into the 1- and 2- positions of UBA.

Connect the two Monopolar (ERG-Jet, DTL) electrodes into the 1+ and 2+ positions of
UBA.

Before the ERG electrodes are actually placed on the corneas, put another drop or two
of the anesthetic in the eye. The anesthetic wears off after approximately fifteen
minutes.

If using a lens electrode, fill the lens of the electrodes with Goniosol or any Methyl
cellulose solution and place the 1+ electrode on the right cornea and the 2+ electrode on
the left cornea, and tape wires to the cheeks. (Follow the directions on the ERG-Jet
electrode box.)

Performing the Test

*
14
14

Click on the Record icon.

If the Baseline appears to be good, click on Record.

If the waveforms are good, click Store to save them. Otherwise, wait a period of time
before repeating the step (wait 2 seconds for step 1, 10 seconds for step 2, and 15
seconds for step 3). Select Step, then Forward. The display will indicate that you are on
the next step.

Repeat these steps (from the Performing the Test section) until the waveforms from
steps 1-5 have been recorded and stored.
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¢ The patient is now completed with the testing. All electrodes can be removed properly.
The affected skin should be cleaned and the corneas washed with saline solution.
+ The waveforms can now be retrieved and analyzed, and the reports printed.

Afterward the appointment
¢ The forehead rest should be cleaned and disinfected using a mild disinfectant such as a
Benzalkonium Chloride wipe or an isopropyl alcohol wipe.
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6 The Visual Evoked Response (VER)

6.1 Overview

The Visually Evoked Response (VER) - also called the Visually Evoked Potential (VEP)
or Visually Evoked Cortical Potential (VECP) — is a test used to measure the electrical
response of the primary visual cortex when visually stimulated. The response is
measured from Brodman's Area 17 of the cortex, an area concerned mostly with foveal
vision. The most commonly used visual stimulus is an alternating checkerboard pattern,
although a flash of light can also be used.

In clinical testing, the electrical response of the visual cortex is measured by placing
one electrode on the scalp directly over the visual cortex, a second on a reference
location (such as the ear) and measuring the difference between these two responses.
The sensitive amplification system is able to measure the difference (typically millionths
of a Volt, or microvolts, uV). Note that a typical wall outlet produces over 100 Volts which
is about ten million times greater than the typical VER signal.

A normal VER is indicative of a properly working visual pathway - from the foveal retina
through the optic nerve to the visual cortex. The VER can provide useful information for
the diagnosis and treatment of many conditions; including, optic neuropathies,
differential diagnosis of unexplained acuity loss (with the focal ERG), and malingering
blindness.

Typically, the VER is recorded in response to an alternating checkerboard stimulus. The
electrical response to this pattern stimulus consists of an initial negative wavelet
followed by a positive one (the VER may contain a few additional wavelets, but only the
first two are of primary clinical significance). There are many factors that can influence
the amplitude of the VER (including skull thickness and electrode location), so the
timing of the waveform is the most useful diagnostic measure in this test. The negative
wave, which generally occurs at 75 milliseconds (ms), is called N75 while the positive
wavelet, which occurs at almost exactly 100 ms, is known as P100. Disease states that
affect the VER prolong the waveform, leading to an increased timing in the P100
wavelet.

The flash VER is most useful in evaluating ocular trauma. It provides evidence of some
foveal vision, indicating that a reconstruction of the eye is likely to be successful. The
flash VER is a complicated waveform that is quite varied between subjects. Usually, the
useful information gathered from the flash VER waveform is whether or not it is present.

6.2 Patient Preparation

Because electrodes will be attached to the scalp, the patient should be advised to wash
their hair within 24 hours of the test and not to use any hair products the day of testing.
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Before starting the test, make sure that the patient is properly refracted.

Errors in refractive correction will give inaccurate test results. The patient can simply
wear their normal prescription eyeglasses or contacts during the test. If the patient's
glasses prescription is not be correct, be sure to check and correct before proceeding
with the test.

The first step is to decide the locations from which to place the electrodes and record.
Usually, a single electrode at OZ and one reference electrode will be sufficient. If the
purpose of the test is to diagnose pre- versus post-chiasmal optic nerve defects,
electrodes must be placed at both 01 and 02.

Nasion Cz

Fp
Nasion

A1 A2

l

Inion

Typical recording sites and landmarks for the VER

To identify the recording sites to place the electrodes on the patient’s scalp, first identify
the inion, the bony protrusion at the back of the skull.

If you are recording on an adult with a normal-sized head, the Oz is
located about 2.5 cm (1 inch) above the inion on the midline. 01 and
02 are located 2.5 cm (1 inch) to the left and right of Oz.

If the subject has an abnormal-sized head, is an infant, —or if it is important that the
electrodes are placed in the exact locations, making a few measurements will determine
the locations for the recording sites. First, identify the nasion, the bony ridge along the
brow line just above the nose on the front of the head. Measure the distance from the
nasion, over the head, to the inion. Next, locate the two pre-auricular points, the bony
protrusions of the mastoid bone just in front of the ear and measure the distance around
the back of the scalp between the two pre-auricular points.

¢ The Oz point is located on the midline, 10% of the distance from the inion to
the nasion above the inion.

¢ O1is located at the same elevation as Oz, 10% of the distance between the
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pre-auricular points to the left of midline
¢ O02is located at the same elevation as Oz, 10% of the distance between the
pre-auricular points to the right of midline

6.3 VEP Electrodes

The VEP is measured using three types of
electrodes: the recording (positive) electrodes,
the reference (negative) electrode, and the
common (ground) electrode. The positive
electrodes are gold cup electrodes, as shown on
the right. This electrode is typically placed in the
Oz location. The negative electrode is typically
either an ECG electrode or another gold cup
electrode. This is typically placed on the
forehead, or along the Fp site. The common
electrode is typically an ear clip.

Clean the electrode site thoroughly to remove all skin oils and other debris that might
inhibit the electrode to making a good electrical contact.

Fill the cups of the ear clip electrode with electrode gel (not cream) and clip it to the
patient’s ear lobe. Then connect this to the ground/common site on the amplifier.

Locate the positive electrode site(s). Part any hair to expose the skin at the recording
site, and vigorously scrub the skin with an electrode prep pad. (If the patient’s hair is
long, bobby pins or other clips should be used to hold the hair out of the way during this
process.)
Note: It is important to clean the scalp thoroughly to obtain a good
electrode contact.

Using a generous dollop of electrode cream (not gel); paste the hair on each side of the
part to the scalp or use bobby pins to securely hold down the hair. The important thing
is to keep the scalp exposed. Next, put a generous portion of electrode cream in the
cup of the electrode and press the electrode firmly into place on the scalp. Cover the
electrode with a 2 to 3 cm (1 to 1%z inch) square of tissue paper, and press firmly again.

Repeat this procedure for each electrode being used. Plug the other end of the
electrode into the positive (+) side of the Amplifier unit, taking note of which electrode is
plugged into which channel if you are using more than one.

The negative (reference) electrode is typically an ECG electrode that is placed on the
forehead, attached to a wire and place in the negative side of the amplifier unit. If you
have more than one positive electrodes, attach a splitter to the end of the negative
electrode and place them in the corresponding negative channels on the amplifier.
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6.4 Recording data

6.4.1 Setting Up the Test

After the electrodes have been attached to the patient, the test can begin. This section
of the manual contains information that was explained in the Software Manual.
¢ From the Main Menu, click on Perform Tests -> Visual Evoked Response ->
Pattern.
¢ Fill in the patient information (as much as possible, but at least the First and
Last Names).
¢ Enter the number of channels used/electrodes to be recorded from. Label the
channels with the name of the site (Oz, O1, etc.) Select which eye is being
recorded and click continue.

The test is now ready to begin. Make sure the patient is seated comfortably and located
the correct distance away from the screen. This distance is specified on a label on the
pattern monitor.

Note: Any muscle contraction may be picked up as noise on the
recording, so it is important that the patient is as relaxed as possible
in order to get a decent recording.

6.4.2 Record

Now click on the Record Icon. The baseline should look somewhat like a good
baseline of other tests. There should be about 20 to 50 pV of signal visible on
the screen (most of this is EEG activity generated by the brain).
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® Data Acquisition ped

Bad VEP Baseline

The shown baseline is an example of a bad baseline. The patient may be tensing his
neck/shoulder muscles so that a large amount of EMG (muscle electrical activity) is
measured. If the patient’s baseline looks like this one, encourage the patient to relax as
much as possible.

If the baseline appears to have a large number of vertical lines on the screen spaced
about 15 milliseconds apart (20 milliseconds apart in Europe and Asia), then there is
power line interference. The most likely cause of this baseline is poor electrode contact.
Be sure to press firmly on each of the scalp electrodes and try another baseline.

Note: Poor electrode contact is the most common reason for poor VER
recordings!

6.4.3 Recording Data

When the baseline is acceptable, it's time to record. Just before clicking on Record,
instruct the patient to carefully watch the screen and to think about something else (about
20% of patients are able to reduce their VER amplitude by concentrating on other
topics).
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The default VER protocol will average 80 responses to obtain a waveform. The number
of responses averaged appears in the lower right portion of the screen. If, while
watching the waveform (which displays every 10 sweeps), it does not significantly
change, the test may be safely stopped. In most cases, as few as 30 responses will
give you a satisfactory recording.

When the recording has finished, instruct the patient to relax. Patient fatigue can affect
the test results, so encourage them to close their eyes and relax. It is a good idea to wait
a few seconds between the tests to allow the patient to recover.

The first stimulus presented in the pattern VER protocol is a checkerboard composed of
32 x 32 alternating squares. For most purposes, this stimulus will be the only one
needed. If other responses are desired, the check sizes in the default pattern VER
protocol will be:

32x32,8x8,16 x 16, 64 x 64, 128 x 128

When testing multiple responses to different check sizes, click on Step Forward )
Icon to go to the next check size.

Remember to store the waveforms (by clicking Store). If the waveforms are not | (O
stored, the software will automatically prompt you if you want to save them or | K5
not.

When the test is finished, return to the Main Menu by clicking on the Return {}
Icon.

6.4.4 Cleanup

Gently remove the electrodes from the patient's scalp. The electrode cream should be
cleaned out of the patient's hair using warm, damp paper towels. Electrode cream is not
soluble in alcohol, so electrode prep pads will not be able to remove it.

6.5 Reports and Analysis

To prepare the reports on a particular patient,

¢ Retrieve the waveforms for that patient (see section 10.6.5 for more info).

¢ Place the appropriate cursors on those waveforms (section 10.6.9 for more
info).

¢ Print out the reports (section 10.6.10 for more info).

6.5.1 Retrieving waveforms

To retrieve the waveforms, start from the main menu and select Create Reports. Fill in
the necessary information to search for and retrieve the waveforms (for more detailed
information see section 10.6.5).
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6.5.2 Analysis

To analyze the waveforms retrieved, click on the Cursors icon. Place cursors on the
waveform as shown in the figure below. Place Cursor 1 at the bottom of the major
trough, which usually occurs at 70 milliseconds. Place Cursor 2 at the top of the %
peak, which usually occurs at 100 milliseconds.

Note: Patients with a disease may have significantly altered peak/trough

timing.

Pattern VER

 arc-minutes 100% Contrast Checks 2 Hz

150

milliseconds

After the cursors are placed properly on the waveform, click on the Store icon u
to save the cursor positions with the waveform. —]

6.5.3 Smoothing

Before printing the waveform, it may be a good idea to smooth it. Smoothing the
waveform will remove the small bumps. To smooth, click on Analyze ->Smooth
or use the smooth icon. If you smooth the waveform and then click on the save | %
icon it will save as a new waveform. See section 10.6.2 for more info on
smoothing.
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THE FOLLOWING ARE STEP BY STEP QUICK GUIDES FOR VEP

May be copied and kept with your device for reference

STEP-BY-STEP INSTRUCTIONS FOR PERFORMING THE VEP

Computer Setup before Patient Preparation

L4

L4
L4
L4

L4

Turn the device on.

Select Perform Test -> Visual Evoked Response.

Select the type of VER to be done (Pattern or Flash).

Add the patient information. If recording from only one channel, the electrode at the
midline is labeled O z. If recording from two channels, the left channel is labeled O1,
and the right channel is labeled 02.

Select the eye to be tested (Right, Left, Both).

Patient Preparation

*

Seat the patient at the specified distance on the label at the bottom of the screen from
the pattern stimulator.

Clean the ear lobe and the OZ location in the back of the head with alcohol prep pads,
allow the alcohol to dry.

Fill both cups of the ear clip electrode with electrode gel and attach it to the ear lobe.
This electrode should be connected to common ground (green) channel on the UBA.
Part the hair at the midline.

Hold the hair down on the scalp by using secure bobby pins or electrode cream on both
sides of the part,

Fill the gold cup electrode with electrode cream and place it in the middle of the part,
directly on the scalp, pressing down firmly on the electrode.

Use a one square inch of Kleenex tissue and place it over the electrode to insure the
electrode is attached tightly to the scalp.

Connect the electrode to the 1+ location of the UBA.

A reference electrode is placed using an additional gold cup electrode, or alternatively
an EKG forehead patch.

Performing the Test

The Standard Pattern VER Test contains a five-step protocol. In each step the pattern size is
changed. For devices with manual Pattern Stimulators, it is essential to change the pattern size
according to the stimulus conditions found at the bottom of the computer screen.

L4
L4

Select Record.

If the baseline appears normal, click Record. During the test, the number of sweeps
averaged is displayed at the bottom of the screen.

When the waveform is sufficient, select Stop and then Store. It is possible to finish the
averaging and not record a perfectly smooth waveform. It is up to the technician to decide
whether to repeat the test or to reposition the electrodes and then repeat the test.

Once a satisfactory waveform has been stored for a step, select Step and Forward.
This will take the test to the next step.

Repeat the last four steps until step 5 has been successfully recorded and stored.

At this point, if a Normal Intensity Flash VER or Bright Flash VER is not needed, the
patient can be disconnected, cleaned or electrode gel and released.

The waveforms can then be retrieved, cursors placed and analyzed, and reports printed.
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7 The Electro-oculogram (EOG)

7.1 Overview

The electro-oculogram (EOG) measures changes in the standing potential of the eye in
dark and light conditions. The standing potential of the eye is generated across the
retinal pigment epithelial (RPE) layer, thus the EOG primarily measures RPE function.

The EOG is a somewhat more difficult test than the ERG or VER, taking more than 30
minutes to complete. Consequently, it is less common than other visual electrodiagnostic
tests. Nevertheless, there are some conditions where the EOG is quite useful; it is
necessary in the diagnosis of Best's disease.

The standing potential of the eye causes it to act like a weak battery. The anterior
(corneal) pole of the eye is more positive than the posterior pole. It is not possible to
measure the standing potential of the eye directly, as this would involve inserting an
electrode behind the globe, so the EOG is measures the potential indirectly.

To perform the EOG, two electrodes are placed on the skin next to the eye - one is
placed near the temporal canthus and the other is placed near the nasal canthus. The
patient then looks left and right. As the eye swings toward the nasal electrode, it becomes
more positive than the temporal one. As the eye swings toward the temporal electrode, it
becomes more positive than the nasal one. The difference between the temporal and
nasal values is related to the potential across the eye.

Because the potential measured by this technique is related to many factors including
the placement of the electrodes and the geometry of the eye, the value is of little use by
itself. The clinically useful value is the ratio of the peak value in the light to the minimum
value in the dark. This is called the Arden Ratio:

V.
. light k
Arden Ratio = —2—P2%

dark trough
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Patient Preparation

According to ISCEV standards, the patient should be maximally dilated using a
medium-acting mydriatic, such as Tropicamide. The patient should not be dark adapted
before the test.

Note: The patient should not be exposed to bright lights, such as a
slit lamp or ophthalmoscope, for at least 20 minutes before the test.

7.2 Electrodes

The EOG uses four EOG recording electrodes
(two for each eye).

Using an electrode prep pad, carefully clean
the skin near the nasal and temporal canthi
as well as one ear lobe. Take care to remove
all skin oils, but don't get alcohol in the
patient's eye. The EOG electrodes are
attached to the patient using electrode
washers, thin disks with adhesive on both
sides. Remove the protective covering from one side of the electrode washer and affix it
carefully to the EOG electrode. Align the washer so that its tab is near the electrode wire.
Next, fill the cup of the EOG electrode with electrode gel (not cream). The gel should
protrude slightly from the surface of the electrode washer. Remove the protective
covering from the second side of the electrode washer and affix the electrode as close
to the canthus of the eye as possible. A gold
cup ear clip electrode is used for ground
electrode and should be plugged into the
ground connection of the amplifier.

Attach the EOG electrodes as follows:
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7.3 Obtaining Data

After you have attached the electrodes, the test may begin. This section requires an
understanding of the UTAS software. For more information on the software, read the
UTAS Software Section first.

7.3.1 Setting up the Test

+ From the Main Menu, click on Tests -> Electro-oculogram.

+ Fill'in the patient information (at least the First and Last Names).

+ Enter the number of channels (electrodes) to be recorded. Usually with
both eyes, channel 1 is labeled R and channel 2 is labeled L.

Seat the patient in front of the Ganzfeld. Make sure that the patient is comfortable, as
they will be sitting there for more than half an hour without a break. Instruct the patient to
look at the red light in the center of the Ganzfeld bowl. Tell the patient that when the lights
begin to move, they should follow the lights with their eyes without moving their head.

7.3.2 Baseline

The software automatically starts in baseline mode. The LEDs will move from right to
left immediately and the patient should follow these lights. See below for examples of a
good and bad EOG baseline. To check for good electrode contact, perform an
impedance check (which should be less than 40KQ). If the wave is too large, interrupt
the baseline, adjust the scale display to a lower setting, and run the baseline again.

Recording time=00:00:00
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Good EOG Baseline

Recording time=00:00:00

Bad EOG Baseline

7.3.3 Recording Data

Once a good baseline has been established, the recording can begin. Click on
Interrupt to stop the baseline and then click on Record to start the test.

The EOG collects data for the first 15 seconds of every minute. During these 15 seconds,
the patient must consistently follow the alternating EOG fixation lights.

Note: An important part of the technician’s job during the test is to
help the patient remain alert (and stay awake) and to inform them of
their progress.

The clock at the top right of the screen will measure the time of the test. At 55 seconds
into each minute, warn the patient that the lights will begin flashing in five seconds.
When each minute starts, the EOG lights will begin flashing. The patient's eye
movements can be monitored on the screen. If they are not moving their eyes with the
lights, encourage the patient to follow the lights. At 15 seconds into each minute, the
EOG lights will stop flashing and the center fixation light will turn on. Let the patient
know that they can relax while still looking at the fixation light.
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The EOG test consists of three phases:
¢ A pre-adapt phase (light on), lasting 6 minutes.
¢ A dark adapt phase (light off), lasting 16 minutes.
¢ A light adapt phase (light on), lasting 14 minutes.

Under normal circumstances, these times will not need to be changed.

Note: Make sure the patient does not close his or her eyes during the
pre-adapt or light adapt portions of the test.

When the test is finished, the software will automatically display the result. Be sure to
store the data. After, the electrodes can be removed from the patient and they can be
released.

7.3.4 Saving EOG raw data

After each 15 seconds segment of alternating LED, the Save button will be available.
Clicking this icon will save the raw EOG data for that segment into C\EMWIN\EOG. To
save all of the raw data, click on Save after each 15 second segment is recorded.

7.4 Report and Analysis

To prepare the patient reports:

¢ Retrieve the specific waveforms (see section 10.6.5).
¢ Place cursors on the waveforms (see section 10.6.9).
¢ Print out the reports (see section 10.6.10).

From the Main Menu, click on the Create Reports. Fill in the necessary patient
information and retrieve the waveforms (they will be labeled "Electro-oculogram").

To place the cursors automatically to calculate the Arden Ratio, click Analyze ->
Computer Arden Ratio. The program will place cursors on the lowest point in the dark
trough and the highest point in the light peak. Occasionally, the cursor will not be placed
in the best locations. ISCEV guidelines state that cursors should be placed based on an
appropriate imagined smooth curve through the data.

For example, if the patient fell asleep during the dark adapt portion of the test, there may
be a few minutes where the computed value was close to zero. The program may select
one of those values and give you an artificially high Arden ratio (in which case, cursors
should be manually changed).

To change a cursor value, click on the Cursors icon. Move the cursor to the &n
correct location. An example of an EOG with proper cursors is shown on the
next page.
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7.5 Fast Oscillation EOG

“The fast oscillation EOG is an optional additional test that has a different mechanism to
the clinical EOG owing to the shorter dark and light intervals used. At light onset, there
is a fall in potassium in the sub-retinal space that causes a strong outward
hyperpolarizing potassium current across the RPE’s apical membrane and is reflected
in the c-wave of the electroretinogram (ERG). The fall in sub-retinal potassium also
reduces the transport of chloride ions into the RPE. The reduction in chloride ions
causes the basolateral membrane to hyperpolarize and lowers the TEP generating the
trough of the FO 3545 s after light onset. The TEP returns to normal, as ionic
homeostasis is restored and a peak is recorded during the subsequent dark period after
a further 35—45 s. The alternation between dark and light at 1-min intervals establishes
a continuous oscillation that is dependent on changes in ionic permeability at the apical
and basal membranes and the electrical coupling between these membranes by tight
junctions.

The FO has the opposite polarity to the EOG. Light causes a decrease in the standing
potential, while in darkness there is an increase in the standing potential.The FO is
recorded using the same technical specifications as the EOG (amplifier, electrode
placement, fixation targets, background luminance and 1/s saccades). However, the
saccades and the recording should be continuous for the duration of the test. Light and
dark intervals are alternated at 60 or 75-s intervals to induce the FO, which has a near
sinusoidal appearance. The total number of light—dark intervals should be at least 4.
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Pre-adaptation does not affect the FO, so this test can be performed either
independently or before the EOG."?

2 Constable PA, Bach M, Frishman LJ, Jeffrey BG, Robson AG; International Society for Clinical
Electrophysiology of Vision. ISCEV Standard for clinical electro-oculography (2017 update) [published
correction appears in Doc Ophthalmol. 2017 Apr;134(2):155]. Doc Ophthalmol. 2017;134(1):1-9.
doi:10.1007/s10633-017-9573-2



Testing the Patient

THE FOLLOWING ARE STEP BY STEP QUICK GUIDES FOR EOG
May be copied and kept with your device for reference

STEP-BY-STEP INSTRUCTIONS FOR PERFORMING THE EOG

Computer Set up Before the Patient Arrives

L4
L4
L4

*

Turn the device on.

Select Test -> Electro-oculogram.

Add the patient information line by line. Add comments as needed, up to three lines.
The EOG test is always a two-channel test and the channels are labeled automatically.
The patient can now be prepped for the test.

Patient Hook-Up

L4

*

*

Clean the forehead, ear lobe, and the temporal and the nasal canthi of both eyes

with alcohol pads. Pat the areas dry. Take care to avoid getting alcohol in the

patient's eyes.

Stick the electrode washers to the flat inner side of four EOG electrodes, leaving the paper
cover on the exposed side. Position each "washer" so that its tab aligns with the
electrode wire.

Fill the electrodes with gel.

Remove the washer tape covers and place the electrodes on the patient.

Each eye should have one + electrode and one — electrode (one of each color).

Connect the electrodes to the corresponding channels of the UBA.

Performing the Test

*

The software will automatically start in Baseline mode. Check the eye movements (the
size of the peaks) to see if they seem uniform and of good amplitude, if so, then click
Interrupt.

Select Record to start the test.

The patient's eye movements should be constantly monitored to ensure the patient
remains alert and does not close their eyes during any phase of the test.

The machine will automatically place cursors on the waveforms and display the Arden
Ratio at the end of the test.

If there are anomalous high points in the light adapting phase or anomalous low points in
the dark adapt phase, the Arden Ratio will not be correct. The cursor positions will need to
be changed by selecting Cursors from the menu.
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Appendix 1: LKC Normal Data

Normative Data for the Clinical Electroretinogram

Means and Standard Deviations as a Function of Age for the Most Commonly Measured
Parameters of the International Standard (ISCEV) ERG Protocol

Monopolar Electrodes (e.g. ERG-Jet)

Stimulus Parameter Change With Age S.D.
-24 dB Scotopic Flash |b-wave amplitude 330 pV - 2.2 yVlyear 61 Vv
0 dB Scotopic Flash b-wave amplitude 644 pV - 1.6 yVlyear 117 pv
b_-wave implicit 47 5 ms 3ms
time
Oscillatory Potentials summed amplitude | 235 pV - 2.1 yV/year 50 pVv
0 dB Photopic Flash b-wave amplitude 183 pV - 1.0 pViyear 37 uwv
b-wave implicit 29.5 ms 1.5 ms
time
30 Hz Photopic Flicker Amplitude 133 puV - 0.7 pViyear 30 uv
implicit time 26.8 ms + 0.02 ms/year 1.8 ms
Bipolar Electrodes? (e.g. Burian-Allen)
Stimulus Parameter Change With Age S.D.
-24 dB Scotopic Flash b-wave amplitude 260 pV - 1.7 pyViyear 48 pVv
0 dB Scotopic Flash b-wave amplitude 507 pV - 1.3 pViyear 92 pv
b-wave implicit time 47.5 ms 3 ms
Oscillatory Potentials summed amplitude 185 pV - 1.7 yVliyear 39 pv
0 dB Photopic Flash b-wave amplitude 144 pV - 0.8 pViyear 29 uv
b-wave implicit time 29.5 ms 1.5 ms
30 Hz PhOtOpiC Flicker Amplitude 105uV-0.6 pV/year 24 uv
implicit time 26.8 ms + 0.02 ms/year 1.8 ms

(+0.03) times those of a monopolar electrode, such as the ERG-Jet

ERG amplitudes for bipolar electrodes, such as the Burian-Allen bipolar electrode are 0.79
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How To Use the ERG Normative Data

ERG amplitudes decrease with age, while some implicit times increase with age.
Consequently, some of the normative data provided are expressed as a value plus or
minus a change per year of age. ERG amplitudes also depend on the type of electrode
(monopolar or bipolar) that is used. Make sure to use values from the table that is
appropriate for the electrodes used. For example, to calculate the mean value of b-
wave amplitude for the 0 dB scotopic flash response of a 67 year old patient using an
ERG-Jet electrode:

1.6 uV
year

Mean = 644 uV —( x 67 yearsJ

ERG amplitudes and implicit times will vary among individuals and all are approximately
normally distributed. Accordingly, 95% of all normal values will fall below 1.65 standard
deviations from the mean. For the 67-year-old patient above, the 0 dB scotopic flash
response would have a 5% chance of being normal if it were below 537 - (1.65 x 117) or
344 pV. To determine cutoff probabilities other than 5%, use the table below to select
the appropriate multiplier.

Probability Multiplier
25% 1.96
5% 1.65
10 % 1.28

Notes:

e These normative data are valid for subjects between the ages of 20 and 80.
Extrapolations to younger or older ages should be made with care.

e Oscillatory Potential amplitudes were determined using the Analyze Oscillatory
Potentials function of LKC's software package. They were not determined using the
analog filtered waveform.

e The 30 Hz flicker amplitude and implicit time were determined using the Flicker
Amplitude and Timing function of LKC's software package. They were not
determined by placing cursors on the waveform.

e Clinicians must exercise judgement in the interpretation of a patient’s result when
compared to reference data. Never draw diagnostic conclusions from a single exam
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and heed the subject’s medical history. It is the clinician’s responsibility to make
diagnostic interpretations of UTAS measurements.

e Test specificity is the probability a test correctly identifies healthy subjects. If using
95% reference limits as clinical decision limits, the specificity will be 95%: About 1 in
40 visually normal subjects will be flagged as outside the 95% reference interval.

e Test sensitivity is the probability that a test will identify a diseased subject. If using
reference limits as clinical decision limits, recall that reference intervals are
constructed only using healthy subjects. The effect that a particular disease has on
any given test may be very large or may be nothing at all. Therefore, test sensitivity
is unknown.

The data reported here were collected under a grant to LKC from the National Eye
Institute. ERG data was collected from one eye of 122 subjects with
ophthalmoscopically normal fundi and no history of diabetes. Their ages ranged from
22 to 79, with approximately equal representation in each decade. Cursors were placed
on waveforms by experienced technicians. Linear regression was used to determine
the age-dependence of each parameter.

Normative data for other ERG parameters of interest was measured with a
monopolar electrode.

To determine the normal value for any age, add the constant value to the product of the
patient's age and the change per year (if any). For bipolar electrodes, divide amplitude
values by 1.26. The 95% limits of normal are the mean £ 2 S.D.

Stimulus and Parameter . Normal Valug S.D. Distribution
(Linear Regression) Shape

0 dB Scotopic Flash a-wave amplitude 387 uV - 2.1 pViyear 70 uv Normal
0 dB Scotopic Flash a-wave implicit 21.2ms + 0.03 ms/year | 1.0 ms Unknown
time
30 Hz Scotopic Flicker amplitude 126 pv - 0.3 pv/year 30 pv Normal
30 Hz Scotopic Flicker implicit time 27.5 ms +0.06 ms/year | 2.2 ms Unknown
Naka-Rushton /og K -2.68 + 0.006/year 0.20 Lognormal’
Naka-Rushton Rmax 558 uV - 0.83 yV/year | 113 uyv Normal

* Data are lognormal after addition of a constant.
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Limits of Normal for the Clinical Electroretinogram

95% Limits of normal as a function of age for the most commonly measured parameters of the
International Standard (ISCEV) protocol using monopolar electrodes

-24 dB Scotopic Flash b-wave Amplitude should be above:

| Age 20 30 40 50 60 70
Amplitude (uV) 185 163 141 119 97 75
0 dB Scotopic Flash b-wave Amplitude should be above:
Age 20 30 40 50 60 70
Amplitude (UV) 419 403 387 371 355 339
0 dB Scotopic Flash b-wave Implicit Time should be below:
Age 20 30 40 50 60 70
Time (ms) 52 52 52 52 52 52
Oscillatory Potential Amplitude should be above:
Age 20 30 40 50 60 70
Amplitude (uV) 110 89 75 61 50 50
0 dB Photopic Flash b-wave Amplitude should be above:
Age 20 30 40 50 60 70
Amplitude (WV) 102 92 82 72 62 52
0 dB Photopic Flash b-wave Implicit Time should be below:
Age 20 30 40 50 60 70
Time (ms) 32 32 32 32 32 32
30 Hz Photopic Flicker Amplitude should be above:
Age 20 30 40 50 60 70
Amplitude (UV) 70 63 56 49 42 35

30 Hz Photopic Flicker Implicit Time should be below:
Age 20 30 40 50 60 70

Time (ms) 30 30 30.5 30.5 31 31
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Limits of Normal for the Clinical Electroretinogram

95% Limits of normal as a function of age for the most commonly measured parameters of the
International Standard (ISCEV) protocol using bipolar electrodes

-24 dB Scotopic Flash b-wave Amplitude should be above:

| Age 20 30 40 50 60 70
Amplitude (uV) 146 129 111 94 77 59
0 dB Scotopic Flash b-wave Amplitude should be above:
Age 20 30 40 50 60 70
Amplitude (UV) 331 318 306 293 280 268
0 dB Scotopic Flash b-wave Implicit Time should be below:
Age 20 30 40 50 60 70
Time (ms) 52 52 52 52 52 52
Oscillatory Potential Amplitude should be above:
Age 20 30 40 50 60 70
Amplitude (V) 87 70 59 48 40 40
0 dB Photopic Flash b-wave Amplitude should be above:
Age 20 30 40 50 60 70
Amplitude (WV) 81 73 65 57 49 41
0 dB Photopic Flash b-wave Implicit Time should be below:
Age 20 30 40 50 60 70
Time (ms) 32 32 32 32 32 32
30 Hz Photopic Flicker Amplitude should be above:
Age 20 30 40 50 60 70
Amplitude (UV) 56 50 44 39 33 28

30 Hz Photopic Flicker Implicit Time should be below:
Age 20 30 40 50 60 70

Time (ms) 30 30 30.5 30.5 31 31
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Normative data for ERG b/a amplitude ratio

Methods: Data was collected from the right eye of 110 normal subjects aged 22 to
79. There was approximately the same number of subjects in each decade. ERG
responses were measured from the “maximal response” step (0 dB scotopic flash) of
the ISCEV standard ERG protocol. Cursors were placed on the waveform by
experienced technicians. A-wave amplitude was measured from a quiet spot on the
baseline to the trough of the a-wave. B-wave amplitude was measured from the trough
of the a-wave to the peak of the b-wave.

B-wave/A-wave amplitude ratios were computed and the change with age was
determined by linear regression.

Results: B-wave/A-wave amplitude ratio changed significantly with the age of the
patient (p = 0.0011, t-test); however, there is a large standard deviation which results in
a low correlation coefficient (R? = 0.09). Linear regression of B-wave/A-wave amplitude
ratio results in the following relationship:

Mean b_ 1.64 +[.0095 x Age(years)]
a

Limits of Normal for Visually Evoked Potentials

95% Limits of Normal for P10o Latency of the
Pattern Visually Evoked Potential

Checks on Check Size Upper Limit of Normal

Screen (minutes of arc) (ms)

4 x4 199’ 119

8x8 100 110
16 x 16 50' 109
32 x32 25' 118
64 x 64 12' 123

128 x 128 6' 141

Check sizes are given for the recommended viewing distance of 1.0 meter

Limits of Normal for Features of the
Flash Visually Evoked Potential

Feature Lower Limit Upper Limit
N4o 36 60
P71 50 90
No1 70 120
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P114 95 155
N154 115 200

Note: Amplitudes of the pattern and flash Visually Evoked Potential are highly variable
and are seldom of clinical interest.
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Appendix 2: Recommended Literature and Website
Website:

ISCEV (International Society for Clinical Electrophysiology of Vision)
Website: https://iscev.wildapricot.org/

Books:

Fishman, GA, Birch, DG, Holder, GE and Brigell, MG (2001) Ophthalmology Monograph
02: Electrophysiologic testing in disorders of the retina, optic nerve, and visual pathway.
American Academy of Ophthalmology, 2nd Edition 2001.

Principles and Practice of Clinical Electrophysiology of Vision, Second Edition
Edited by John R. Heckenlively and Geoffrey B. Arden
Steven Nusinowitz, Graham E. Holder and Michael Bach, Associate Editors


http://mitpress.mit.edu/catalog/author/default.asp?aid=31037
http://mitpress.mit.edu/catalog/author/default.asp?aid=31038
http://mitpress.mit.edu/catalog/author/default.asp?aid=31039
http://mitpress.mit.edu/catalog/author/default.asp?aid=31040
http://mitpress.mit.edu/catalog/author/default.asp?aid=31041

Appendix 3

Appendix 3: Standard Protocols

The following pages contain the software settings for each of the LKC standard
protocols that come with the UTAS. Some of the protocols are repeated for different
stimulators (e.g., the Standard ERG protocol appears for the Grass Flash and

Kurbisfeld stimulators).

The protocols are organized by test: ERG protocols, VER protocols, and EOG

protocols.

Step:

High Pass Channel 1 (Hz}):
High Pass Channeal 2 (Hz):
High Pass Channal 2 (Hz):
High Pass Channel 4 (Hz}:
High Pass Channeal & (Hz):
High Pass Channeal & (Hz):

Low Pass Channel 1 (Hz):
Low Pass Channel 2 (Hz):

Low Pass Channel 2 (Hz):
Low Pass Channel 4 (Hz):
Low Pass Channel & (Hz):
Low Pass Channel & (Hz):

Notch Filters:

Stmulator:

Flash Intensity :
LEDY XEMOM:

Color X

W

Single Flash / Fllckar:
Flickar Rate (Hz):
Pre-Adapt (sec):
Background Light:
Whites/Color® Amber:
Color X

L

Fixation Light:

Mumber to Average:

Time Batwean Sweaps{sec):
Sweeps Before Update:
Artifact Reject (uv):

Display Raw Wavelorm:
Store Individual Sweeps:
Reajection of Clipped Data:

Sample Rate (Hz):
MHumber of Sampla:
Pre-Stim Basaline (msec):

2008 STANDARD ERG PROTOCOL

Protocol in CALNEMWIiN\Standard Protocols\stdergU.pro

2300
300
200
2300
2300
300

OFF

Ganzield
-24 dB
uw LED

Flicker
10.0
10
OFF

LKC Technologies

200
200
200
200
200
200

OFF

Ganzield

-24 dB
U LED

Flasn

2 Professional Drva

Gaithaersburg, MD 20873

WA LT SO

3 4
0.3 0.2
0.3 0.2
03 0.2
0.3 0.2
0.3 0.2
0.3 0.2
200 300
200 200
200 200
200 300
200 300
200 200
OFF OFF
Ganzield Ganzield
O dE O de
U LED v LED
Flash Flash
OFF OFF
Dim Dim
1 1
o100 o100
o (o
2000 2000
YES YES
MO MNO
Unchecked Unchecked
2000 2000
B12 512
20 20

2300
300
200
2300
2300
300

OFF

Ganzfeld
o ds
w LED

Flicker
10.0
10
S0co mim
uw LED

OFF

1
0.100
o
200
VES
[l

Unchecked

2000
512
20

300
0o
300
300
300
0o

OFF

Ganzfeld
odBe
i LED

Flash

2ocadimim
uv LED

a0
YES
[ L)
uUnchackad

2000
512
20

300
200
200
300
300
200

Ganzield
0 dBe
v LED

Flickar
30.2
2
20ca™mm
v LED

10
0.033

500
VES

unchackad

2000
512
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ERG EXTENDED PROTOCOL

Protocol in CHANEMWIin'Standard Protocols\ISCEVextended2011 .pro

Step:

High Pass Channel 1 (Hz):
High Pass Channel 2 (HzZ):
High Pass Channel 2 (Hz):
High Pass Channel 4 (Hz):
High Pass Channel & (HzZ):
High Pass Channel & (Hz):

Low FPass Channel 1 (HZ):
Low Pass Channel 2 (Hz):
Low Pass Channel 2 (Hz):
Low FPass Channel 4 (HZ):
Low Pass Channel & {Hz):
Low Pass Channel 6 (HZ):

Motch Filters:

Stumulator:

Flash Intensity :
LEDY XEMOM:

Color »:

W

Single Flash /s Flicker:
Flicker Rate (Hz):
Pre-Adapt (sec):
Background Light:
White/Color’ Amber:
Color X:

S

Fixation Light:

Mumber to Average:
Time Batwaan Swoops(soc):
Sweeps Before Update:
Artifact Reject (uv):

Display Raw Wavelorm:
Store Individual Sweeps:
Rejection of Clipped Data:

Sample Rate (Hz):
Number of Sample:
Pre-stim Bassaline (msec):

0.3
0.3
0.3
0.3
0.3
0.3

L=t}

Sanzfeld
-24 ag
v LED

Flicker
10.0
10
OFF

LK C Technologies

2 Professional Drva
Gathersburg, MD 20879

0.2
0.2
0.2
0.2
0.2
0.2

500
500
500
500
500
500

[t}

Sanzfeld
-24 dB
U LED

Flasn

OFF

Biz2

W LS OO

0.2
0.3
0.3
0.2
0.3
0.3

R
SGanzfeld

1 ae
v LED

Flash

OFF

YES
Unchecked
2000

512
20

500
500
500
500
500
500

L=l
‘Ganzfeld

1 de
v LED

Flash

oOFF

Unchecked

2000
Bi2
20

0.2
0.2
0.2
0.2
0.2
0.2

Unchecked

2000
512
20

O

Sanzfeld
14de
v LED

0.100
o
200
YES
O

Unchecked

2000
Bi2
20

o3
03
0.3
o3
03
0.3

(=1}
Sanzfeld

1ae
U LED

Flasn

YES
L bl

Unchecked

2000
Biz2
20

0.3
0.3
0.3
0.3
0.3
0.3

f= )

Ganzfeld
14ae
U LED

Flicker
20.2
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Appendix 3

CLASSIC ERG PROTOCOL

Protocol in CAEMWIintStandard Protocols\clasergU. pro

Step:

High FPass Channel 1 (Hz):
High FPass Channel 2 (Hz):
High FPass Channel 2 (Hz):
High FPass Channel 4 (Hz):
High FPass Channel 5 (Hz):
High Pass Channel 6 (Hz):

Low Pass Channel 1 (Hz):
Low Pass Channel 2 (Hz):

Low Pass Channel 3 (Hz):
Low Pass Channel 4 (Hz):
Low Pass Channel & (Hz):
Low Pass Channel & (Hz):

MNotch Filters:

Stmulator:

Flash Intensity:
LEDY XEMNOMN:

Color >

W

Single Flash 7 Flickear:
Flicker Rate (Hz):
Pre-Adapt (sec):
Background Light:
White/Color” Amber:
Color X:

A

Fixation Light:

MuMmbar to Average:
Time Between SWeeps(sSec):
Sweeps Belore Update:
Artifact Reject (L)

Display Aaw Wavelornm:
Store Individual Sweaps:
Rejection of Clipped Data:

Sample Rate (Hz):
MNumber of Sample:
Pre-Stum Baseling (msec):

0.3
0.3
0.3
0.3
0.3

500
500
500
500
500
500

Sanzfeld
-24 dB
v LED

Flicker
10.0
10
OFF

OFF

0.100

200
YES

uUncheacked

2000
s12

LKC Technologies
2 Profassional Drva
Galtharsburg, MD 20879
WY LR SO

2 2 4 3
0.2 0.2 0.2 0.2
0.2 0.2 0.2 0.2
0.2 0.2 0.2 0.2
0.2 0.2 0.2 0.2
0.2 0.2 0.2 0.2
0.2 [+ -] 0.3 0.3
BOO s00 500 500
BOO s00 500 500
BOO s00 500 500
BOO s00 500 500
500 500 =00 =00
500 500 =00 =00
o oM L ) oM
Sanzfeld Ganzfeld Sanzfeld Sanzfeld
-24 dB -2ade odas o de
v LED v LED v LED o LED
Flasn Flash Flash Flicker
10,0
10
OFF OFF OFF Zocd'mm
v LED
Cim Dim Diim OFF
1 1 1 1
0.100 o100 0.100
o o o
200 1000 200
YES YES YES YES
M MNC NO [ L)

uUnchecked Unchecked Unchecked uUnchecked

2000 2000 2000 2000
B12 512 512 512
20 20 20 20

Sanzfeld
ode
o LED

Flasnhn

F0cd/mm
 LED

YES

uUnchecked

2000

512
20

0.3
0.3
0.3
0.3
0.3
.3

500
500
500
500
500
500

Sanzfeld
o ae
uw LED

Flickar
20.2

20cdimm
uw LED

10
0.033

500
YES
N
unchecked

2000
512
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FLICKER ERG PROTOCOL

Fago 1

Protocol in CAEMWIin\Standard Protocols\flickergUJ. pro

LKC Technologies

2 Protassional Driva
Gathorsburg, MD 20870
WYY LK GO

Step: 1 2 k= 4 B

=] 7 =
High Pass Channel 1 (Hz): 0.3 0.2 0.3 0.3 0.2 0.2 o3 03
High Pass Channel 2 (Hz): 0.3 0.2 0.3 0.3 0.2 0.2 o3 03
High Pass Channel 2 (Hz): 0.3 0.2 0.3 0.3 0.2 0.2 o3 03
High Pass Channel 4 (HZ): 0.3 0.2 0.3 0.3 0.2 0.2 o3 03
High Pass Channel & (Hz): 0.3 0.2 0.3 0.3 0.2 0.2 o3 03
High Pass Channel & (HZ): 0.3 0.2 0.3 0.3 0.2 0.2 o3 03
Low FPass Channel 1 (Hz): 200 200 200 200 300 300 300 200
Low FPass Channel 2 (Hz): 200 200 200 200 300 300 300 200
Low FPass Channel 2 (Hz): 200 200 200 200 300 300 300 200
Low FPass Channel 4 (Hz): 200 200 200 200 300 300 300 200
Low Fass Channel & (Hz): 200 300 200 200 300 300 300 300
Low Fass Channel & (Hz): 200 300 200 200 300 300 300 300
Motch Filters: OFF OFF OFF OFF OFF OFF OFF OFF
Stmulator: Sanziaeld Sanzield Ganzield Sanzield Ganzield Ganzfeld Ganzfeld Sanzfeld
Flasn Intensity oae o ae oae o ae o de ode o aBe oaBe
LEDY XEMCOM: U LED U LED U LED U LED u LED uw LED uw LED U LED
Color X:
A
Single Flash / Flicker: Flicker Flicker Flicker Flicker Flicker Flicker Flicker Flilcker
Flicker Rate (Hz 5.0 10.0 14.9 20.0 26.0 230.3 24.5 40.0
Pre-Adapt (sec 2 2 3 3 a3 a3 a3 2
Background Light: B0ca/mm B0ca/mm 30ca’mm 3oca’mim Joca’'mm 20ocdi/mm 2o0ca/mm B0ca/mm
WhiteyColor AmbDer: U LED U LED U LED U LED u LED uw LED uw LED U LED
Color X:
A
Fixation Lignt: oim oim Dim Dim D Dim Dim oim
MHumber to Average: 10 10 10 10 10 10 10 10
Time Betwaan Sweeps(sac): 0.200 o.100 0.057 0.050 0.040 0.033 0.029 0.025
Sweeps Belore Update: o o o o o o o o
Artifact Reject (uv): 500 500 500 500 500 500 500 500
Display Raw wWavelonm: YES YES YES YES YES YES YES YES
Store Individual Sweeps: [ ] [ ] NO [ [ Mo Mo Mo g (]

Rejection of Clipped Data:  Unchecked uUnchecked Unchecked Unchecked Unchecked Unchecked Unchecked uUnchecked

Sample Rate (Hz): 2000 2000 2000 2000 2000 2000 2000 2000
Mumber of Sample: g1z g1z s1z B12 B1z2 &1z &1z g1z
Pre-stm Bassline (msec): o o

o o o o o &)
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PATTERN ERG PROTOCOL

Protocol in CAEMWIiNn'\Standard Protocols\patergU . pro

LKC Technologies
2 Profassional Driva

Gaithersburg, MD 20879
WA L GO

Step: 1
High Pass Channel 1 (Hz): 0.3
High Pass Channal 2 (Hz}: 0.2
High Pass Channel 3 (Hz): 0.3
High Pass Channal 4 (Hz}: 0.2
High Pass Channel & (Hz): 0.3
High Pass Channel 6 (Hz): 0.3
Low Pass Channel 1 (Hz}): 200
Low Pass Channel 2 (HzZ): 200
Low Pass Channel 3 (Hz}): 200
Low Pass Channel 4 (HZ): 200
Low Pass Channel & (HZ): 200
Low Pass Channel 6 (Hz}: 200

Motch Filters: OFF
Stimulator: Pattern
Style: Checks
Horzontal: 22
Wertical: az
Color #1: Black
Color #2: White
FPosition: Full
Contrast(%:): 100
Alternation Type: Allermating
Alternation Rate(Hz): 4
oSO Time: 1:1
Mumber to Average: 100
Time Between Sweaps(sec): 0.266
Sweeps Belore Updata: B
Artifact Reject {uv): 260
Display Raw Wavelornm: ]
Store Individual Sweeps: L]

Rejection of Clipped Data: unchackead

Sample Rate (Hz): 2000
HMumber of Sample: 512
Pre-Stim Basaline (msec): [a]
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BRIGHT FLASH ERG PROTOCOL

Protocol in CAEMWIiN\Standard Protocols\bergU._ pro

LKC Technologies
2 Profassional Drva
Gaitharsburg, MD 20873
WYL RO OO

Step: 1
High Pass Channel 1 (Hz): 0.3
High Pass Channel 2 (Hz): 0.3
High Pass Channel 3 (Hz): 0.3
High Pass Channel 4 (Hz): 0.3
High Pass Channel & (Hz): 0.3
High Pass Channel & (Hz): 0.3
Low Pass Channel 1 (Hz): 300
Low Pass Channel 2 (Hz): 200
Low Pass Channel 3 (Hz): 300
Low Pass Channel 4 (Hz): 200
Low Pass Channel 5 (Hz): 200
Low Pass Channel & (Hz): 300
Motch Filters: OFF

Stimulator: Ganzfeld

Flash Intensity : 25 dBe
LEDV MEMOM: HEMNOM
Color X:
L
Single Flash 7 Flicker: Flash

Flicker Rate (Hz):
Fre-Adapt (Sec):

Background Light: Z0cd/mm
WhilteyColor Amber: U LED
Color X:
R
Fixation Light: CHm
MuMmber to Average: 10
Time Between Sweeps{sec): 0.356
sSweeps Before Update: o
Artifact Reject (Lwv): 2000
CHsplay Raw Wwavelorm: YES
Store Indlvidual Sweeps: MO

Rejection of Clipped Data: Unchecked

Sample Rate (Hz): 2000
Mumber of Sample: B12
Pre-Stim Bassaline (msec): 20
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DOUBLE FLASH ERG PROTOCOL

Protocol in CAEMWIiN\Standard ProtocolsidbergU._ pro

LKC Technoclogies
2 Professional Driva
Galtharsburg, MD 20879
VWYL KIS OO

Step: 1
High Pass Channel 1 (Hz): 0.3
High Pass Channel 2 (Hz): 0.3
High Pass Channel 2 (Hz): 0.3
High Pass Channel 4 (Hz): 0.3
High Pass Channel 5 (Hz): 0.3
High Pass Channel & (Hz): 0.3
Low Pass Channel 1 (Hz): 200
Low Pass Channel 2 (Hz): 300
Low Pass Channel 2 (Hz): 200
Low Pass Channel 4 (Hz): 300
Low Pass Channel & (Hz): 300
Low Pass Channel & (Hz): 200
Notch Fliters: OFF

Stmulator: DoubleFlash

Flash Iintensity #1: 25 de
LEDV XENOM: HEMNOMN
Collor X 0.289
W 0.220
Flash Iintensity #2: oae
LED Color: White
Color »:
h
Delay (mseac): 200
Background Light: OFF
Background Solor:
Color
h
Fixation Light: im
Mumber to Average: 10
Time Betwaan Sweeps{sec): 0.556
Sweeps Before Update: lu]
Artifact Reject (uwv): 16500
Display Raw Wavelorm: YES
Store Individual Sweeps: [ ]

Rajection of Clipped Data:  Unchecked

Sample Rate (Hz): 2000
Mumber of Sample: B12
Pre-Stim Bassaline (msec): 20
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ON/OFF ERG PROTOCOL

Protocol in CAEMWIin\Standard Protocols\onoffergU. pro

LK.C Technologies
2 Prolassional Driva
Galtharsburg, MD 20879
WIWWLLKC.COM

Step: 1
High Pass Channel 1 (Hz): 0.3
High Pass Channel 2 (Hz): 0.3
High Pass Channel 2 (Hz): 0.3
High Pass Channel 4 (Hz): 0.3
High Pass Channel 5 (Hz): 0.3
High Pass Channel 6 (Hz): 0.3
Low Pass Channel 1 (Hz): 200
Low Pass Channel 2 (Hz): 200
Low Pass Channel 2 (Hz): 200
Low Pass Channel 4 (Hz): 200
Low Pass Channel 5 (Hz): 200
Low Pass Channel 6 (Hz): 200
Notch Fliters: OFF

Stmulator: Sanzfeld

Single FlashvFlIlcker Onolrr: L g Tl )
Responselntensity (cd/mimj: 550
Background LED Color: v LED
Color »:
™
onTime{ms): 200
Background Light: 160cad/mm
WhniteSColor Amber: v LED
Color »:
™
Fixation Light: Cirm
Mumber to Average: G0
Time Between Sweaps(sec): 0.656
Sweeps Belore Updata: o
Artifact Reject {uv): 200
Display Raw wavelorm: YES
Store Individual Sweeps: L]

Rejection of Clipped Data: Unchecked

Sample Rate (Hz): 2000
HMumber of Sample: 512
Pre-Stim Basaline (msec): 20
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PHOTOPIC NEGATIVE RESPONSE ERG PROTOCOL

Protocol in CAEMWIin\Standard Protocols\pnrergJ. pro

LKC Technologies
2 Protassional Driva

Gaithersburg, MD 20879
WA L GO

Step: 1
High Pass Channel 1 (Hz}: 0.3
High Pass Channel 2 (Hz): 0.3
High Pass Channel 3 (Hz): 0.3
High Pass Channel 4 (Hz): 0.3
High Pass Channel 5 (Hz): 0.3
High Pass Channel & (Hz): 0.3
Low Pass Channel 1 (Hz): 200
Low Pass Channel 2 (Hz): 200
Low Pass Channel 3 (Hz): 200
Low Pass Channel 4 (Hz): 200
Low Pass Channel 5 (Hz): 200
Low Pass Channel & (Hz): 200
Motch Filters: OFF

Stimulator: Ganzfeld

Flash Intensity : odBe
LEDY XEMNCM: v LED
Color x:
o
Single Flash / Flicker: Flash

Flicker Rate (Hz):
Pre-Adapt (S2c):

Background Light: 10cd/mm
white/Color Amber: Custom Colar
Color X: ]
RS o
Fixation Light: CHm
Mumber to Average: 10
Time Batween Sweeps(sec): 0.356
Sweeps Before Update: o
Artitact PReject (uv): 250
Display Raw Wavelorm: YES
Store Indvidual Sweeps: =]

Rejection of Clipped Data:  Unchecked

Sample Rate (Hz): 2000
HMumber of Sample: 512
Pre-Stim Basaline (msec): 20
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S-CONE ERG PROTOCOL

Protocol in CLMEMWIin\Standard Protocols\sconerglU._ pro

LKC Technoclogies
2 Professional Driva
Galtharsburg, MD 20879
VWYL KIS OO

Step: 1
High Pass Channel 1 (Hz): 0.3
High Pass Channel 2 (Hz): 0.3
High Pass Channel 2 (Hz): 0.3
High Pass Channel 4 (Hz): 0.3
High Pass Channel 5 (Hz): 0.3
High Pass Channel & (Hz): 0.3
Low Pass Channel 1 (Hz): 200
Low Pass Channel 2 (Hz): 300
Low Pass Channel 2 (Hz): 200
Low Pass Channel 4 (Hz): 300
Low Pass Channel & (Hz): 300
Low Pass Channel & (Hz): 200
Notch Fliters: OFF

Stmulator: Sanzfaeld

Flash Intensity -10 dB
LEDY MEMOM: L LED
Collor X
o
SFingle Flash 7 Flickar: Flasn

Flicker Rate (Hz):
Pre-Adapt {sec):

Background Lignt: 200cd/mm
wWhite/Color Amber: uw LED
Caolor X:
¥
Fixation Lignt: oim
MHumber to Average: 50
Time Bstwesn SWeeps{sec): 0.256
Sweeps Belore Update: o
Artifact Reject (uv): 260
Display Raw Wavelorm: YES
Store Individual Sweeps: (Nl=]

Rejaction of Clipped Data: unchackad

Sample Rate (Hz): 2000
Mumber of Sample: Bi12
Pre-Stim Basaline (msech: 20
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PATTERN VEP PROTOCOL

Faga 1

Protocol in CAEMWIiN\Standard Protocols\pvepl. pro

LKC Technologies

2 Profassional Drvea
‘Gaithersburg, MD 20872
WA LG SO

Step: 1 2 3 4 B

High Pass Channel 1 (Hz): 0.3 0.3 0.3 0.3 0.2
High Pass Channal 2 (Hz}: 0.3 0.2 0.3 0.2 0.2
High Pass Channel 3 (Hz): 0.3 0.3 0.3 0.3 0.2
High Pass Channal 4 (Hz}: 0.3 0.2 0.3 0.2 0.2
High Pass Channel & (Hz): 0.3 0.3 0.3 0.3 0.2
High Pass Channel 6 (Hz): 0.3 0.3 0.3 0.3 0.2
Low Pass Channel 1 (Hz}): 200 200 200 200 300
Low Pass Channel 2 (HzZ): 200 200 200 200 200
Low Pass Channel 3 (Hz}): 200 200 200 200 300
Low Pass Channel 4 (HZ): 200 200 200 200 200
Low Pass Channel & (HZ): 200 200 200 200 200
Low Pass Channel 6 (Hz}: 200 200 200 200 300
Motch Filters: OFF OFF OFF OFF OFF
Stimulator: Pattern Pattern Pattern Pattern Pattern
Style: Checks Checks Checks Checks Checks
Horzontal: 22 2 1G (=53 128
Wertical: az a 16 (= iz28
Color #1: Black Black Black Black Black
Color #2: White White White White White
FPosition: Full Full Fuill Fuill Full
Contrast(%:): 100 100 100 100 100
Alternation Type: Alternating Alternating Alternating Alternating Alternating
Alternation Rate{Hz}: 2 2 2 2 2
oSO Time: 1:1 1:1 1:1 1:1 1:1
MHumber to Average: ao ao a0 a0 a0
Time Betwean Sweeps(sec): 0.500 0500 0.500 0.600 0.600
Sweeps Belore Updata: B B (=3 (=3 &
Artifact Reject {uv): 260 260 260 250 250
Display Raw Wavelorm: YES YES YES YES YES
Store Individual Sweeps: L] L] N N N
Rejaction of Clipped Data: unchackead Unchecked Unchacked Unchacked Unchecked
Sample Rate (Hz): 2000 2000 2000 2000 2000
NMumber of Sampla: B12 BE12 512 512 512

Pre-Stim Basaline (msec): o] o] o o o
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PATTERN VEP ISCEV 2011

Protocol in CAMEMWIN\Standard Protocols\|SCEVZ2Z011VEPRP. . pro

Faga 1

LK.C Technologies
2 Prolassional Driva
Galtharsburg, MD 20879
WIWWLLKC.COM

Step: 1 2 2 4 &
High Pass Channal 1 {(Hz}: 0.3 0.2 0.3 0.2 0.2
High Pass Channel 2 (Hz): 0.3 0.3 0.3 0.3 0.2
High Pass Channal 3 (HzZ}: 0.3 0.2 0.3 0.2 0.2
High Pass Channel 4 (Hz): 0.3 0.3 0.3 0.3 0.2
High Pass Channal & (Hz}: 0.3 0.2 0.3 0.2 0.2
High Pass Channal & (Hz}: 0.3 0.2 0.3 0.2 0.2
Low Pass Channel 1 (Hz): s00 &00 500 500 500
Low Pass Channel 2 (Hz}): &OD &00 500 500 500
Low Pass Channel 2 (Hz): s00 &00 500 500 500
Low Pass Channel 4 (Hz}): &OD &00 500 500 500
Low Pass Channel & (Hz}): &OD &00 500 500 500
Low Pass Channel & (HzZ): s00 &00 500 500 500
MNotch Fllters: Ll Ll 2 2 oM
Stimulator: Pattern Pattern Pattern Pattern Pattarn
Style: Checks Checks Checks Checks Checks
Horizontal: az i28 a 16 (=5}
wWertical: 22 128 a 16 (=53
Color #1: Black BElack Black Black Black
Color #2° Wwhite Wwhite wWhite wWhnite whnite
Position: Full Full Full Full Full
Contrast{%.): 100 100 100 100 100
Alternation Type:  Alernating Alternating Alternating Alternating Alternating
Alternation Rate{Hz): 2 2 2 2 2
NSO Time: 1:1 1:1 1:1 1:1 11
MNMumber 1o Average: a0 a0 a0 20 20
Time Batwean Sweaps{sac): 0.500 0.500 0.500 0.500 0.500
Sweeps Belore Update: B B & & &
Artifact Reject (uv): 260 250 250 250 250
Display Raw Wavelornm: L] L] N N N
Store Individual Sweeps: L] L] MNC MNC NO

Rejection of Clipped Data:  Unchecked Unchecked Unchecked Unchecked Unchecked

Sample Rate (Hz): 2000 2000 2000 2000 2000
MNumber of Sample: Bi12 Ei12 512 512 512
Pre-Stim Basaline (msec): o o o o o
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ISCEV PATTERN ONSET PROTOCOL

Faga 1

Protocol in CAEMWIiN\Standard Protocols\patternBlankVERU pro

LKC Technologies
2 Profassional Driva
SGaithaersburg, MD 20873
WA L GO

Step: 1 -]
High Pass Channel 1 (Hz): 0.3 0.3
High Pass Channel 2 (Hz): 0.2 0.2
High Pass Channel 3 (Hz): 0.3 0.3
High Pass Channel 4 (Hz): 0.2 0.2
High Pass Channel & (Hz): 0.3 0.3
High Pass Channel & (Hz): 0.3 0.3
Low Pass Channel 1 (Hz): 300 200
Low Pass Channel 2 (Hz): 200 200
Low Pass Channel 3 (Hz): 300 200
Low Pass Channel 4 (Hz): 200 200
Low Pass Channel 5 (Hz): 200 200
Low Pass Channel & (Hz): 300 200

Motch Filters: OFF OFF
Stimulator: Pattern Pattern
Style: Checks Checks
Horiz ontal: az 128
Wertical: as 128
Color #1: Elack Elack
Color #2: wWhite wWhite
Position: Full Full
Contrast(?:): 100 100
Alternation Type: Pattern Blank Pattern Blank
Alternation Rate(Hz): = =
Onot Time: 21 2:1
Mumber to Average: a0 a0
Time Betwesen Sweeps(sec): 0.602 0.602
Sweeps Belore Update: B B
Artifact Reject (uv): 246 246
Display Raw Wavelonm: YES YES
Store Individual Sweeps: ] ]

Rejection of Clipped Data: Unchacked Unchecked

Sample Rate (Hz): 2000 2000
NMumber of Sampla: B12 BE12
Pre-Stim Basaline (msec): [a] [a]
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FLASH VEP PROTOCOL

Page 1

Protocol in CAEMWIin\Standard Protocolsi\fvepl. pro

LKC Technologies
2 Profassional Drva
Gaitharsburg, MD 20873
WYL RO OO

Step: 1
High Pass Channel 1 (Hz): 0.3
High Pass Channel 2 (Hz): 0.3
High Pass Channel 3 (Hz): 0.3
High Pass Channel 4 (Hz): 0.3
High Pass Channel & (Hz): 0.3
High Pass Channel & (Hz): 0.3
Low Pass Channel 1 (Hz): 500
Low Pass Channel 2 (Hz): 500
Low Pass Channel 3 (Hz): 500
Low Pass Channel 4 (Hz): 500
Low Pass Channel 5 (Hz): 500
Low Pass Channel & (Hz): 500
Motch Filters: OFF

Stimulator: Ganzfeld

Flash Intensity ode
LED XEMOM: U LED
Color X:
R
single Flash ¢ Flicker: Flicker
Flicker Rate (Hz): 2.0
Pre-Adapt (sec): 2
Background Light: OFF
WhilteyColor Amber:
Color X:
R
Fixation Light: CHm
MuMmber to Average: 20
Time Between Sweeps{sec): 0.600
sSweeps Before Update: o
Artifact Reject (Lwv): 150
CHsplay Raw Wwavelorm: YES
Store Indlvidual Sweeps: MO

Rejection of Clipped Data: Unchecked

Sample Rate (Hz): 2000
Mumber of Sample: B12
Pre-Stim Bassaline (msec): ]
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INTENSITY RESPONSE PROTOCOL

Stap

Amplifier Display Scale {uv):
Amplifier Gain Settings:

Low Cut Channels 1 (Hz):
Low Cut Channeals 2 (Hz):
Low Cut Channeals 2 (H=):
Low Cut Channels 4 (Hz):

High Cut Channeals 1 {Hz):
High Cut Channels 2 (Hz}:
High Cut Channals 2 (H=):
High Cut Channals ¢ (Hz):

MNotch Filters:

Stimulator:

Fla=zh Intensity:
LEDY XENON:
Color >

s

Single Flash / Flicker:
Flickar Rata (Hz):
Pra-Adapt {sac):
BEackground Light:
Background LED:
Color -

A

Fixation Light:

MNumlbzer to Avarage:

Time Betweaen Sweepsdsad):
Swaaps Bafora Updata:
Artifact Rajact {uwv):

Display Raw Wavaform:
Store Individual Sweeps:
Rejaction of Clipped Data:

Sample Rate (Hz):
Mumber of Samplea:
Fre-Stim Baseline {(maeac):

Protocaol in CAREMwinMRergl) pro

LKC Technologies, Inc.
2 Professional Drive

Gaithersburg, MD 20879
WA LK GO

1 =2 2 4
250 250 250 =250
= ] =t =S =t
o3 o3 32 o2
0.3 0.3 0.2 0.2
0.3 0.3 0.2 0.2
[c) [oRc) a3 (e
S S0 S [=laju)
So0 500 500 500
So0 500 500 500
S S0 S St
>FF >FF 2 FF oFF

Ganzfeld Sanzfeld Sanzfeld Ganzfeld
-4 dB -z dB -2& dB -24 dB

White LED White LED White LED VWhitae LED

Flash Flash Flash Flash
>FF >FF 2 FF oFF
DCirn Crirm Ciirn Diirn

1 1 1 1
[a 3 §ala] a3 Raln] [ Rada) [a 3 Raia)

13 a3 a3 o+

o <] o <]
YES YES YES YES
N Nz N NI

Unchackad Uncheackead Uncheackead Unchackad

p=iajuja} p=iajuia} praujaiad praajaia]
51z 51z 51z 512
20 20 20 20

=250
=L

o2
[aec)
[aec)
[ c)

[=laju)
f=laju)
f=laju)
St

OFF

Ganzfeld

-3z dB
White LED

Flash

OFF

YES
M
Unchackad

praajulay
512
20

Sl
f=laja}
f=laja}
Sl

OFF

Ganzfeld

-an dB
White LED

Flash

OFF

YES
N
Unchackead

praaja ey
s1=
20

SO0
=1

o3
32
32
2

S0
SO0
SO0
S0

OFF

Sanzfeld

-z dB
White LED

Flash

OFF

YES
N
Uncheckead

praujaday
512
20

S0
=1

o3
3
3
[Rc)

SoC
S0
S0
j=taju]

OFF

Sanzfeld

-z& dB
White LED

Flash

OFF

M
Uncheackead

p=ialuie}
512
20




Appendix 3

Step:

Amplifier Display Scale {uv):
Amplifiar Gain Settings:

Low Cut Channeals 1 {Hz):
Low Cut Channels 2 {Hz):
Low Cut Channels 2 {Hz):
Low Cut Channels 4 (Hz):

High Cut Channels 1 {HzZ):
High Cut CGhannels 2 {Hz):
High Cut Channeals 2 {Hz):
High Cut Channels 4 {Hz):

MNotch Filters:

Stimulator:

Flash Intensity:
LEDY XEMNOMN:
Color -

g

Zingle Flash 7 Flicker:
Flickar Rate {Hz):
Pra-Adapt {sac):
Background Light:
Background LED:
Color >

A

Fixation Light:

MNumkber to Average:

Time Batweaen Swaops{sac):
Sweaaps Baefora Updata:
Artifact Reject {uv):

Dizplay Raw Waveform:
Store Individual Sweaeps:
Fajaction of Clippaed Data:

Sample Rate {Hz):
Numizer of Sample:
Fre-Stim Bassaline {m=ac):

Protocol in CAEMwinMRergl pro

500
=t

o2
o2
o2
o2

S0
S0
500
500

OFF

Sanzfald

-24 dB
White LED

Flash

OFF

N
Uncheckad

p=salala]
512
=20

LKC Technolagies, Inc.

2 Professional Drivie

Gaitherstkurg, MD 20879

500
wEg

[aRc)
[aRc)
[aRc)
[aRc)

S0
S0
500
500

OFF

Sanzfald

-zzdB
White LED

Flash

OFF

wES
N
Unchackad

p=Julala]
512
=20

WY LRI CHOM

S0
wEg

[aec)
[aec)
[aec)
[aec)

S0
S0
(=]
S0

OFF

Sanzfeld

-z dB
White LED

Flash

OFF

M
Unchackad

p=laluja]
512
=20

1z

S0
wEg

o3
o3
o3
o3

S0
S0
S0
500

OFF

Sanzfeld

-1sdB
White LED

Flash

OFF

YES
N
Uncheckad

p=iualala]
512
20

12

j=dla]
e

S0
S0
[=ala]
S0

OFF

Sanzfeld

-1 dB
White LED

Flash

OFF

YES
N
Unchackad

2000
512
=20

14

500
e

3
3
3
3

S0
S0
B0
500

OFF

Sanzfald

-14 dB
White LED

Flash

OFF

N
Unchackad

2000
51z
=20

15

f=le o]
=]

o3
o3
o3
o3

S0
S0k
B0
B0

OFF

Ganzfald

-1z dB
White LED

Flz=h

OFF

YES
M
Uncheackad

2000
512
=20

1

f=lala)
=]

o3
o3
o3
o3

SO0
S0
[=lala)
B0

OFF

Ganzfeld

-1 dB
White LED

Flash

OFF

M
Uncheckad

2000
512
=20




Appendix 3

Protocaol in CAREMwinddRergl pro

LKC Technologies, Inc.
2 Professional Drive

Gaithersburg, MDD 20870
WA LK SO

Stap: 17 1= 1z 20 21 22 23 =21
Amplifier Display Scale (uvi: 500 500 1250 1250 1250 1z50 1z50 1z50
Amplifier Gain Settings: =t pli=t] pli=t] pli=t3 e HEd wEd wEd
Low Cut Channels 1 (Hz): a3 L) a3 a3 3 a3 a3 a3
Low Cut Channals 2 (Hz): 0.3 [ 3c) a3 a3 0.3 0.2 0.2 0.2
Low Cut Channels 2 (Hz): a3 L) a3 a3 3 a3 a3 a3
Low Cut Channels 4 (Hz): a3 L) a3 a3 3 a3 a3 a3
High Cut Channels 1 {Hz}: 500 500 500 500 500 500 500 500
High Gut Channals 2 {Hz): 500 500 s500 s500 s500 S00 s500 500
High CGut Ghannels 2 {Hz): f=laled 500 500 500 500 500 500 500
High Gut Channals 4 {Hz): 500 500 s500 s500 s500 S00 s500 500
Motoh Filters: OFF 2FF 2FF oFF oFF FF 2FF 2FF
Stimulator: Sanzfeld Sanzfeld Sanzfeld SGanzfeld Gianzfeld Ganzfeld Ganzfeld Ganzfeld
Flash Intensity: -o di -5 dB -4 dB -=dB o dB = di 4+ dB = dB
LEDY XEMNOMN: White LED White LED White LED White LED White LED White LED White LED White LED
Color X
hgs
Single Flash f Flickar: Flash Flash Flash Flash Flash Flash Fla=h Flash

Flickar Rata {(Hz):
Fre-Adapt (sac):

Background Light: oFF oFF 2 FF OFF = FF OFF oFF >FF
Background LED:
Color x:
N
Fixation Light: Cim Cim Cim Cim Ciim Ciim Ciim Dim
Numbzer to Averagea: 1 1 1 1 1 1 1 1
Time Betweaen Sweeps{sec): o100 3% [ala) 3% fala] [0 Nalad o 100 o100 (a3 falad (a3 Nl
Sweaaps Before Updata: 4] 4] 4] 4] 4] 4] 4] 2]
Artifact Rejact {uv): o o o o o o o o
Dizsplay Raw Waveform: YES g == WES WES YES YES YES YES
Store Individual Sweaeaps: M M N N N N M M

Fejaction of Clipped Data:  Uncheckead Unchacked Unchackad Unchackead Unchackad Uncheckad Uncheckad Uncheckad

Sample Rate (Hz}: 2000 2000 00T f=2ulale] 2000 2000 2000 2000
Number of Sample: =3 B=4 51z 51z 51z 51z si1z =% §=3 =% §=3
Fre-Stim Baseline {msac): =0 =0 =0 =0 20 20 20 20
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Srep

Amplifier Display Scale {uv):
Amplifier Sain Saettings:

Loy Sut Channaks 1 (Hz):
Low Cut Channels 2 (Hz):
Lo Sut Shannals 2 (HzZ):
Low Sut Shannels 4 (Hz):

High Cut Chantnels 1 (HZ):
High Cut Channels 2 (Hz}:
High Cut Channels 2 (Hz):
High Cut Chantnels 4 (HZ):

MNotch Filtars:

Stimulator:

Fla=h Intensity:
LEDS XENOMN:
Color

N

Zingle Flash f Flickear:
Flickar Fata {Hz):
Pre-Adayt (sec):
Background Light:
Eackground LED:
Color >

g

Fixation Light:

MNumbear to Avarage:

Time Batweaean Sweaseps{sach:
Sweeps Before Update:
Artifact Pajact {uv):

Cispl &y Ranaw Waraform:
Store Individual Sweaeapps:
Rejaction of Clippad Data:

Sampie Rate (Hz):
Mumizer of Samde:
FPraeStim Baseline msac):

Protocol in CAEMwin\Rergll pro

=5

1250
=t

o2
.32
()
L]

S0
500
S0
S0

OFF
Sanzfald

e dB
HEMNON

Flash

OFF

YES
Mz
Unchecked

=000
s51=
=20

LK.C Technologies, Inc.

2 Prafessianal Crive

Gaithersburg, MD 20579

WA, LI O

=25 =27
1250 1250
e e
2 3
0.3 0.2
3 o3
.32 e
S Bt
500 [=tala)
S St
S Bt
oFF = FF
Sanzfeld Sanzfald
1 dBE 1z dBE
HEMNON HEMOMN
Fla=h Flash
oFF = FF
Crirn Dt
1 1
[ Judal [a3% Nadal
4 +
a3 a3
YWES YES
L Y [
Uncheckad Uncheckeaed
pmdu duu p=aaaleg
512 5412
=0 =0

25

1250
=t

L=lugd)
f=ludu]
S00
L=lugd)

OFF

Sanzfeld

14 dB

HENCN

Fla=h

OFF

N

Uncheckead

2000
s51=
20

==

1250
=T

SO
S50
S
SO

> FF
Sanzfald

1z dB
HENCN

Flaszh

OFF

YES
N
Uncheckad

2000
s1=
=20
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ULTRAVIOLET ERG PROTOCOL (non humans only)

Stap:

Amplifier Display Scale {uwv):
Amplifier Gain Settings:

Low Cut Channals 1 {HZ):
Low Sut Shannaels = (HZ):
Low Cut Channals 2 {HZ):
Low Sut Shannals 4 (HZ):

High Sut Shanneals 1 (HzZ):
High Cut Channals 2 (HZ):
High Sut Shannals 2 (HZ):
High Cut Shannels 4 (Hz):

MNotch Filtaers:

Stimulator:

Fla=h Intensity:
LED/S *EMNCMN:
Color

NI

Zingle Flazsh 7 Flickear:
Flickear Rate {Hz):
Pre-Adapt {(sac):
Background Ligkt:
Background LED:
Color 2

NI

Fixation Ligkt:

MNumbar to Avaerage:

Time Betweaan Swasos{sac):
Sweaaps Before Updata:
Artfact Pajact {uw):

Display Raw WWawvaformm:
Stora Individual Swaass:
Rejaection of Clipped Data:

Sample Rate (Hz):
Mumizar of Sampla:
FPre-Stim Baseline (mseac):

Protocol in CAEMwiniUVergl pro

LKC Technologies, INnc.

2 Prafessional Drive
Gaithersburg, MD 20573
W LR O

S
wiEd

32
3
32
3

S
S
S
S

OFF
Sanzfald

o dB
U LED

Flash

OFF

YES
M
Unchecked

e dajay
512
=20
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GLP/GCP Compliance Package Software

GLP/GCP Compliance Package Software

1 General Information

1.1 Software License

The GLP/GCP Compliance Pack software is a copyrighted product of LKC
Technologies, Inc. and may only be used under the following license agreement:

The software may be used in conjunction with an LKC UTAS only. The purchaser of
the UTAS may make one copy of the software for convenience of use, provided the
LKC copyright notice is preserved with each copy. This license specifically prohibits
the use of this software on any computer that is not directly connected to an LKC
Technologies, Inc. UTAS Interface Unit. The software may be used by the
purchaser of the UTAS, however, to produce reports of UTAS data using one, and
only one, stand-alone computer system.

LKC warrants only that the software will conform to the specifications described in
this manual. If the software is determined not to conform to any specification (a bug)
LKC will take measures necessary to cause the software to conform to
specification(s) (bug fix) as quickly as is possible in LKC’s sole judgment. LKC does
not warrant this software to be suitable for any specific business purpose nor will
LKC be responsible for any incidental or consequential damages associated with its
use including loss of revenue, delay of revenue opportunity or any business impact
of associated testing.

2 General Overview

2.1 What are GLP/GCP and 21 CFR 11?*

The US Food and Drug Administration (FDA) regulated industries, such as Bio-Pharmaceutical,
Personal Care Products, Medical Devices and Food and Beverage, are required to document and
acknowledge conditions and events during development, verification, validation, and
manufacturing of products.

Most governments now require compliance with GLP and GCP (Good Laboratory and Clinical
Practice, respectively) regulations for studies demonstrating the safety or efficacy of regulated
medical products. These regulations require users to prevent electronic data from being
improperly manipulated during the study. Internationally, the standards for Good Laboratory
Practices are maintained by the Organization for Economic Cooperation and Development
(OECD). An index of the relevant guidelines can be found at

* LKC Technologies’ provides this overview and associated Internet links for your convenience. Standards
change and evolve on a regular basis so you should verify the latest requirements and not rely upon this brief
overview as being complete or comprehensive.



GLP/GCP Compliance Package Software

http://www.oecd.org/document/63/0,2340,en 2649 34381 2346175 1 1 1 1,00.html

If you are retaining electronic records in compliance with GLP or GCP, “system design
should always provide for the retention of full audit trails to show all changes to the data
without obscuring the original data. It should be possible to associate all changes to
data with the persons making those changes by use of timed and dated (electronic)
signatures. Reasons for change should be given.” (Application of the Principles of
GLP to Computerized Systems, OECD, 1995).

If you are retaining electronic records for submission of results to FDA, you are required
to comply with 21 CFR Part 11 (Electronic Records, Electronic Signatures, US Code
of Federal Regulations, 1997). These regulations are very similar to the GLP/GCP
requirements and define the conditions under which the FDA can assure “electronic
records, electronic signatures, and handwritten signatures executed to electronic
records to be trustworthy, reliable, and generally equivalent to paper records and
handwritten signatures executed on paper.”

GLP compliance is required for all non-clinical pharmacological and pharmacokinetic studies
designed to test drug safety and efficacy and GCP compliance is required for similar clinical
studies. Additionally, FDA mandates that all FDA-required records stored in electronic format in
place of or in addition to a paper record must be compliant with 21CFR Part 11.

FDA'’s guideline for 21 CFR Part 11 stipulates requirements for creating, maintaining,
approving, archiving, retrieving, printing, and transmitting electronic documentation. It
provides the first definitive set of guidelines for records security. To comply with 21 CFR
Part 11, pharmaceutical companies and medical device manufacturers must limit
system access to authorized individuals (§11.10 (d)). In addition, they must be able to
maintain audit trails for all significant activity and system events (§11.10 (e)). It is the
foundation for good laboratory/clinic practice (GLP / GCP).

The provisions of 21 CFR Part 11 can be summarized as follows:

e Accurate Record Generation (§71.10(b))

e Program Timeouts (§71.10(d), §11.200(a))
e Audit Trails (§71.10(e))

e Event Logging (§71.10(e), §11.300(d))
e Input Checks (§71.10(h))

e Controls for Electronic Signatures  (§71.200)

e Password Expirations (§71.300(b))

LKC Technologies’ EMWin GLP/GCP Compliance Pack is designed to be
compliant with the provisions of 21 CFR Part 11. It features restricted user access
to the computer, verification of users’ identities, device operation, and data. All
the records in the GLP/GCP studies are secured so that only the assigned users
can access them using LKC’s software. All the operations for the study are
stored to provide an audit trail, including the name of the user, access date and
time, action (recording, analyzing, creating reports, printing, etc.).


http://www.oecd.org/document/63/0,2340,en_2649_34381_2346175_1_1_1_1,00.html

GLP/GCP Compliance Package Software

2.2 Will LKC’s GLP/GCP Compliance Pack Guarantee My Study’s Compliance?

LKC’s GLP/GCP Compliance Pack provides a series of safeguards which are
necessary for LKC’s proprietary EMWin software to be GLP, GCP, and 21 CFR Part
11 compliant. However, compliance with these principles requires more than just a
software package. The most recent FDA guidance on application and enforcement of
21 CFR 11 (Guidance for Industry Part 11, Electronic Records; Electronic
Signatures — Scope and Application,
See https://www.fda.gov/downloads/Regulatorylnformation/Guidances/ucm125125.pdf
for a copy) states that the FDA intends to enforce provisions related to

limiting system access to authorized individuals
use of operational system checks
use of authority checks
use of device checks
determination that persons who develop, maintain, or use electronic systems
have the education, training, and experience to perform their assigned tasks
= establishment of and adherence to written policies that hold individuals
accountable for actions initiated under their electronic signatures
= appropriate controls over systems documentation
= controls for open systems corresponding to controls for closed systems bulleted
above (§11.30)
» requirements related to electronic signatures (e.g., §§ 11.50, 11.70, 11.100,
11.200, and 11.300)”
Clearly, many of these provisions require the establishment and enforcement of
Standard Operating Procedures and are beyond the ability of any software package to
provide compliance.

The GLP/GCP Compliance Pack software provides functionality that when properly
implemented as part of a compliant process, will ensure that the correct testing
protocols will be followed throughout the course of the study, that raw data will be
preserved, that manipulated data or procedures will be appropriately documented, that
all records will be properly archived, and that access to data can be audited.

& LKC has developed this GLP/GCP Compliance Pack software in
conjunction with a major pharmaceutical company to be used in their GLP/GCP
environment. LKC believes that this software provides the functionality
necessary to achieve GLP/GCP compliance when implemented as a component
of a compliant process including all of the necessary business processes and
controls necessary to achieve GLP/GCP compliance. LKC cannot and does not
warrant that your process will be GLP/GCP compliant and strongly recommends
that you evaluate the underlying functionality of the GLP/GCP Compliance Pack
software offering to ensure that the functionality provided will allow for
compliance in your environment. Any claim that your process is GLP/GCP


https://www.fda.gov/downloads/RegulatoryInformation/Guidances/ucm125125.pdf

GLP/GCP Compliance Package Software

compliant is yours and yours alone based upon your analysis and resulting
process implementation.



GLP/GCP Compliance Package Software

& This manual often refers to the User’s Manual of your UTAS and the
EMWin software package User’s Manual. We recommend that you keep all of
the manuals together.

3 Installing and Enabling the GLP/GCP Compliance Pack

. If you purchased the GLP/GCP Compliance Pack at the same time as your
UTAS, the software has been pre-installed and configured on your
computer. You can skip this section.

. If you purchased additional licenses of the GLP/GCP Compliance Pack for data
analysis on additional computers follow the instructions to get a software key to
enable GLP/GCP.

3.1 Installing additional licenses & software
Install EMWIN on the new computer using the media provided by LKC when you
purchased additional licenses for analysis, following the onscreen instructions.

3.2 Enabling GLP/GCP and acquiring the Software Key file

Open EMWin by double clicking on the EMWin software icon. The main menu of
EMWin will appear.

* EM for Windows 10 Version 9.7.0

SLKC

TECHNOLOGIES
N DEFINED

Current database: TEST03132019

From the main menu, select Utilities — System Setup. A warning message will pop up.



GLP/GCP Compliance Package Software

EMWINTD

Changing the System Parameters is not recommended.
Are you sure you want to continue?

Click on Yes.

Another dialogue box will open, as shown below

Preferences

System Type Electro-Oculogram GLPIGCP
D uTas @ None @ Present @ None @ Present

Hardware Type Pattern Stimulator
@ None © LCD
@ 3000 With Double Flash

Number of Channels Kurbisfeld Amplifier Type
@2 4 Oc @38 i@ None Q uBA

© cmGs @ mMGS
Ganzfeld

'.i None
Q¥ sunBurst/ BigShot

Kurbisfeld Control
Ultra-Violet © Builtin @

K

Copy the long red Host ID into an email and send to support@lkc.com along with your

company name. LKC will email you back a file named GLP.KEY, copy this file to the
C:\EMEin directory on the computer. Close EMWin if it is open.

Open EMWin by double clicking on the EMWin software icon. The main menu of
EMWin will appear.

*| EM for Windows 10 Version 9.7.0
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From the main menu, select Utilities — System Setup. A warning message will pop up.

EMWINTD

Changing the System Parameters is not recommended.
Are you sure you want to continue?

Click on Yes.

Another dialogue box will open, as shown below

Preferences

System Type Electro-Oculogram GLPIGCP
Q uTas @ None @ Present @ None @ Present

Hardware Type Pattern Stimulator \

@ None © LCD
@ 3000 With Double Flash

Number of Channels Kurbisfeld Amplifier Type
@2 4 Oc @38 i@ None Q uBA

© cmGs @ mMGS
Ganzfeld

'.i None
@ sunBurst/ BigShot

Kurbisfeld Control
Ultra-Violet © Builtin @

In the GLP/GCP section, change the selection from None to Present, and click the OK
box.

EMWin software will return to the Main Menu.
3.3 Operating System and Networking.

The database containing all of the test results and other information will reside on the
computer of your UTAS. However, it is possible for other computers to access the data
over a network.4 A separate license for EMWin and the GLP/GCP Compliance Pack

4 To maintain patient electrical safety, your UTAS must not be connected to a wired local area network
while human patients are being tested.
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software must be purchased for each computer that will access the data. Contact LKC
Technologies for more information about installing and using the software on networked
computers.
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Software Key Prompt
DComForlKC >

App not licensed, Please contact support@lkc.com to request
! . alicense key.

To allow other users to use the EmWin and GLP/GCP compliance pack you must make
the C:/EMWIN a share folder. Go to C:/EMWIN folder and right click, select Properties.
An EMWIN property window will pop up (see figure 7) select Security and choose the
users you wish to have access and give them full control.
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m » ThisPC » Local Disk (C2)

Marmne Date modified Type
2 Brother &/872017 &:33 AM File folder
Cadence B/ 11,/2018 3:21 PM File folder
. DataMFERG 5012019 10:43 AM File folder
ol Eclipse 51072019 946 AM File folder
- EMWin 5/16/2019 3:23 PM File folder
o " EMWin Properties > = felder
M e folder
P| General Sharing Securty Previous Versions Customize e folder
P Object name:  CAEMWin e folder
P e folder
p Group or user names: e folder
5 & tAuthenticated Users e folder
SR SYSTEM fold
te | 82 Administrators (DESKTOP-GC5LIBC Administrators) = reiaEr
u B2 Users (DESKTOP-GC5LSBC Users) e folder
W e folder
|:| r To change pemissions, click Edit. Qﬁdft bplication ext
Permissions for Authenticated
|Isers Allow Deny
Full cortral 2
Modify
Fead & execute
List folder contents
Read
Write W
For special pemissions or advanced settings. Advanced
click Advanced. =

EMWIN Folder Sharing Properties

Then create new Windows account for all the users. Log into each newly created
account and reinstall EMWIN from their account.

4 Creating a GLP/GCP Database
There are 3 steps in creating a new GLP/GCP database:

1. Define the testing protocol
2. Add users and define their roles and privileges
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3. Fill in information to be stored and printed (Institution, Address, report
title, etc.)

The first step in the creation of a study is to create the protocol that will be used. EMWin
has a number of predefined protocols and will also let you create your own User
Defined Protocols (UDP). Please refer to your UTAS User’s Manual for instructions on
how to create a User Defined Protocol.

Make sure that you have defined and stored the protocol that will be
used for testing (or are using a standard protocol supplied with your
device) before creating the GLP/GCP database

All Users of the GLP/GCP Compliance Pack software must have a

Windows account on the UTAS computer before they can access a

GLP/GCP database. The User Name in the GLP/GCP database must
match their Windows User Name.

All the GLP/GCP recorded data and related operation for each study will be stored in its
own encrypted database. To create a new database, start from EMWin main menu and
select: Utilities — Create New Database — GLP/GCP Database. Type in a name for
the database and click on Enter. The GLP/GCP User’s Role window will pop up (Figure
7).

The person creating the database is defined as the SuperUser, also known as the
Administrator. The SuperUser's information (UserName, Password and Role) are
automatically entered, and are those of the SuperUser's Windows account on the
computer. The SuperUser can change his/her EMWin GLP/GCP Compliance Pack
password by typing a new password in the Password field and clicking the Modify
button.

The UserName entered for each individual in the GLP/GCP Compliance
Pack software must be the same as their Windows user name on the
computer. Any user names that are not Windows users can not login to
the GLP/GCP study, even their names are assigned in the study.

Only the Administrator can create a new GLP/GCP database and assign

users and their initial passwords. It is recommended that each user

should change their password immediately after logging in for the first
time
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The SuperUser must enter the User | setGLP/GCP Options

Name for all other users and set their

role. For each user, the SuperUser Options Superllser, - Analyst) [ Viewer

enters the User Name and password, Chaninels v v

selects a Role (SuperUser, Analyzer, Sier Boleis v v

Viewer or Disabled) and clicks on Add. Step to. - v

While the User Name entered in the _

GLP/GCP database must match their Save Selection v v v

Windows User Name, the password can Ao save b b

be different from the user's Windows Cursor Placement v v v

password_ Flace a Comment ~ ~ ~

Pririt [+ ~ ~

The SuperUser should also determine Marwial Reject v 4 v

the privileges associated with each role Export Dialog v v v

by clicking on the Set GLP Options

button; the GLP/GCP option window will & month v v v

open (Figure 8) and the SuperUser can e e s v v v

select the different privileges that he/she ks e it v v v

wants to assign to different roles. et v v v

Privileges are enabled by checking the Basline comect v v v

associated box for that user type. Once _

finished, click OK. Offine Average v v v
Add waveforms ~ ~ ~

The first 5 GLP options are specific to FFT v 5 v

GLP/GCP Compliance Pack protocols: =i i 22 v v v

Channels: Allows the user to change the Diefault | lTl Cancel

number of recording channels. When

disabled, protocols default to two
recording channels.

Step Backwards: Allows a user to go to previous step in the protocol.

Step to...: Allows the user to jump to any step in the protocol.

Save Selection: Allows the user to choose which waveforms to save. If disabled the
user can only save ALL waveforms.

Auto Save: When enabled, data will automatically be saved after each recording and
the study will move forward to the next step in the protocol.

protocol with both dark adapted and light adapted steps. Once the

c The Auto Save can cause difficulties if you are using an ERG
last dark-adapted step is performed, the software will immediately
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turn on the background light. If you need to repeat the dark-adapted
step, the eye will have already become partially light adapted,
making it impossible to repeat last the dark-adapted step. It is
strongly recommended that you NOT enable the Auto Save function
if you are using an ERG protocol with both scotopic and photopic
steps.

. GLP/GCP Study Infomation
All of the other options on

the list of User Privileges
are covered in the UTAS
User Manual; please refer Repart Title: | |
to it if needed.

[ztitution M arme; | LKL Technologies
Once all users have been
added and their roles
. ; : ) 2 Professional Drive
deflned., click on Qu:t.l The Address: Gathersburg, MD 2073
study information window (Use Ctrh-E nter Wi LK. COM

will appear (figure to the to add new line.]

right). From the protocol
drop down menu, select the

protocol that will be used TestType: | |
during the study. All data
collected in the database Protocal: | |

being created will use the

selected protocol.

Study Information Screen

If you select a standard protocol provided by LKC, the report title and test type fields will
be filled out automatically. The SuperUser can change these entries by typing in the
corresponding field.

If you select a User Defined Protocol, the SuperUser must enter both the report title and
the test type.

Once all information has been entered select the OK button. The entered information
will be printed at the top of the page of each report. The software will then return you to
the Main Menu.

5 Selecting a Database
To use the database you just created, it must first be selected.
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From Main Menu, go to Utilities — Select Database — GLP/GCP Database, choose the
correct database from the list and click Open.

A sign-in window will open. Enter your User Name and your GLP/GCP Compliance
Pack password and click OK.

The software will return you to the Main Menu.

Sign In to GLP/GCP

Izer name: |

Paszward: |

Change Pazsword | k. | Cancel

Log on Window
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6 Record[ng data In Patient Information
GLP/GCP mode Last Name

From the EMWin Main Menu, you | [
. . ST Name
can start testing by selecting
Perform Test » GLP/GCP Study [RaECLCEE. |
The patient information window Sirthdate
will appear (Figure 11). The ' ——
minimum information that mustbe [REEEUEN. = 0 |
entered in order to proceed is the Pupil Dilated
information in the first 4 fields of Siamosic
the form. The default categories AgnosE -
are: Electrode (ERG only)
= Animal ID
= Session f'}'::‘
= Sex Other |
n Age Database ANUAL?

Comments

W

Search+ Fill

’T Continue

;
i
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Each field has limited length accepting the characters. The first field (such as LastName
or AnimallD), the second field (such as FirstName or Session), and the third field (such
as Ml or Species) are 30 ASCII characters (15 Unicode characters) long, meaning that
user can enter the longer names up to 30 characters. For the fields of Sex and Age, the
allowable length is 15 characters. Most fields accept up to 30 characters, whereas the
field Other accepts up to 100 characters and Comments accepts up to 300 characters.

There are certain reserved characters that should not be used to
fill in ANY information in the database. The reserved characters
are:

* o 9 # 1 - [ ]

There is one main difference between the regular EMWin software and the GLP/GCP
mode. In the GLP/GCP mode each time the user saves the waveform the software will
automatically go forward to the next step of the protocol. If for any reason the user
needs to go back a step and record again, he/she will be asked to enter the reason for
his/her action (Figure 12). The justification reasons can be preset by a text file
c:\EMWin\jlist.txt. Click “OK” button to accept the typed reason or click “Cancel” button
to the step backwards (or forwards).

Reason For Action >

SkipStep 1 because:

I
OK

Prompt for moving back one step in the protocol

The recording procedure is similar to recording in a non-GLP/GCP database; refer to
your UTAS User’s Manual for details on how to collect data.

7 Managing a GLP/GCP database
Only the defined SuperUser can manage the database. In order to manage a GLP/GCP
database you must first select the database (refer to Section 5). Then from the Main
Menu go to
Utilities — Manage GLP/GCP information.

The managing option window will appear
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Trace-Audit-Trail Medify-User's-Role  Modify-5tudy-Infomation  Modify-Demegraphics  Close window

Managing GLP/GCP database menu

The Administrator has four possible activities: look at the audit trail, modify user roles
and privileges, modify the study information and modify the demographics.

7.1 Trace Audit Trail
The GLP/GCP Audit Trail is presented as a table. Each entry in the table has an Index
number, a User Name, the Action that the user performed (create, select, save,

report...), information about the action and any reason that was given, and the date and
time of the action.

This table can be searched by User Name, Index, Record / Step Number, Reason or
Date.

The audit trail list can also be printed. The printing action itself will be stored in the audit
trail.

GLP/GCP Trace Audit Trail
Index | Userame | Action | Record/Step/lser/DB Location | Memo | Date |

1 rcook Create DB at C:AERWin 16:00:23,05/16/2019
2 rcook Select DB at C:HEMWin 16:04:12.08M16/2019
3 rcook Enter database 16:07:01.05416/2019
4 roook Exit databaze 16:12:01.08M 62019

Current search condition is "whole Audit Trail".

| ction ~l - = ~| List List &1l

Action 2 Fririk

Memo

Date

Audit Trail Table

7.2 Modify User’s Role
A SuperUser can change any user’s role and password from the GLP/GCP User’s Role
window; the privileges associated with each role can also be changed anytime during
the study (refer to Section 4).
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' Users cannot be deleted from the user list. If a user is to be denied
- access to the data, then his/her role should be set to Disabled.

GLP/GCP User's Role

Index I zer ame Fiole Pazsword

recak, Superllzer

dzer's Mame: |f'3'3"3'k dzer's Role: |5uperL|ser - |

Paszward: |

The ugername entered for each individual must be the zame as their windows
LEEMmame on the computer.

Add | Modify Set GLP Options

Change User Role/Privileges

7.3 Modify Study Information
The SuperUser can modify the study information such as Report Title, Institution Name,
and Address. The Test Type and Protocol values will be shown but cannot be changed.
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GLP/GCP Study Infemation

Report Title: | aral2]

[nstitution M arme: | LK.C Technologies

Address 2 Profezzional Drive
853, Gaithershurg, MO 20879

[Uze Chl-Enter i LEC COM
to add new line.) . .

Test Type:  |Standard ERG

L]

Kl

Protocal: | ztdergu.pra

Modify Study Information

7.4 Modify Demographics

The EMWin software provides for the collection of demographic data. The default
demographic data are:

. Patient Name (Last, First, MI) . Diagnosis

" Identification " Electrode Type

. Sex . Pupils Dilated

. Birthdate . Dark Adapt Time

These prompts may not be appropriate for your study. You can change the names of
the demographic data fields using the Modify Demographics option. The definitions are
stored in a text file C:\EMWin\temp\ Demographics.txt, which can also be modified
using a text editor.

Figure 17 shows the Demographics form that is used to rename each of the
demographic data fields. In the example below, the first field in the form, which would
be labeled “Last Name” in normal usage, will be used to hold Animal ID in this study.

Figure 18 shows the resulting Patient Information screen as it will appear during testing
after the Demographics form has been filled out as shown below.
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Patient Information Patient Information

Last Name Animal ID
First Name Session
Middle Initial Speices/Breed

Sex Sex

Birthdate Thursday , May 16,2018 ¥

Identification

Age

Identification
Pupil Dilated Group
Diagnosis Traetment

Electrode Electrode

m
=
9]
=]
=)
=

Dark Adapted

Dark Adapted

Other Other

—
—
—
—
—
I
I
—
—
I
I

Database Database

Comments Comments

W

Search+ Fill

Clear Continue

Search+ Fill

}
i

. . Patient Information Window as it
Modify Demographics appears after Demographics are filled
out as in Figure 16

Changes made to the demographic information are first made in the Demographics.txt
file as noted above. When the GLP/GCP database is created, this information is copied
into the database, but also remains in the Demographics.txt file. Thus:
= |f you want to change the demographic information in your GLP/GCP studies,
you must make these changes before you create the GLP/GCP database.
Items related to GLP/GCP data collection cannot be changed once they are
stored in the database.
= After you create the database, the demographic information will be changed
for non-GLP/GCP operation of the software until you change the
demographic information back again.

& The Birthdate field includes checks to make sure that a valid age or date
of birth is entered. This is true even if you change the name of this field to
something else. The format for date of birth may be MM/DD/YYYY or
DD/MM/YYYY (defined in System Setup). Age format is either a number, or a
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number followed by a letter (d, m, or y). For example, 5d indicates 5 days old, 2m
indicates 2 months old, and 10y indicates 10 years old.

8 Analyzing and Reviewing Data
In order to analyze the data, the user will have to select the GLP/GCP database of
interest, and log in. Then, from the Main Menu select Reports, You can narrow your
search by entering data in the various search fields. If you leave all fields empty, all of
the data stored in that database can be accessed.

Informaticn

Last Name

Record # -
Start Number -

Diagnosis

First Name

Middle Initial

Identification

Il

Sex

Action

Birthdate Thursday , May 16,20M9 -

Age Range

.

Test Date Thursday , MWay 15,2019 - |[CW Thursday , May 16,2018 =

Other

D View Waves

# Export Waves

oo |

W

Test Type

Retrieving Data
The array of possible activities of the user depends on its role and associated
privileges. Refer to the UTAS User Manual for more information on the different
available functions (smooth, print, export data...)

9 Creating reports
Creating report in the GLP/GCP mode is exactly the same as non-GLP/GCP mode.
Please refer to your UTAS User’s Manual for more information on how to create reports.

' All actions in creating reports will be recorded and stored in the
4 audit trail.




